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Introduction

Document history

Version Remarks

V2.0.0 28.08.2007 New Manual - RELEASE status

Table 1: Document history

Conventions used in this manual

To give this manual an easily understood layout and to emphasize important
information, the following typographical styles and symbols are used:

Styles
Style Function Example
Bold Programs, inputs or highlighting |bold

important things

Courier Code listings etc. Input
Upper case Register REGISTER
Italics Modes, fields Mode
Parentheses and/or blue Links (Link)

Table 2: Styles

Symbols
Note This symbol highlights important information.
Caution This symbol highlights important instructions. You have to

follow these instructions to avoid malfunctions.

N

AVT SmartView for FirePackage V2.0.0
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www This symbol highlights URLs for further information. The URL
itself is shown in blue.

T?” Example:

http://www.alliedvisiontec.com

Before operation

We place the highest demands for quality on our software. The FirePackage
SmartView Manual is the guide to the installation of the software and the
operation of AVT cameras with SmartView.

Note Please read through this manual carefully before operating

AVT cameras with SmartView.

AVT SmartView for FirePackage V2.0.0
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AVT SmartView for FirePackage

Hardware conditions

e PC or laptop with built-in IEEE 1394 interface

e TEEE 1394 adapter (OHCI) card for PCI bus or PCI Express bus or PC card
or ExpressCard with IEEE 1394 port(s)

Note AVT offers a wide range of IEEE 1394 adapters, both 1394a or

1394b for different requirements.

FireWire hot plug precautions

Note Although FireWire devices can be hot-plugged without pow-

~ ering down equipment, we recommend turning the computer
power off, before connecting a digital camera to it via a
FireWire cable.

Operating system conditions
e Windows NT4
e Windows 2000

* Windows XP (32 and 64 bit)
e Windows VISTA (32 bit)

Software conditions

e Windows NT4/2000/XP/VISTA: AVT FirePackage

Note The AVT FirePackage includes a special IEEE 1394 device
driver from INTEK suitable for all AVT cameras which replaces

@ the MS 1394 driver stack completely.

AVT SmartView for FirePackage V2.0.0
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Overview FirePackage

e Install IEEE 1394 adapter (if PC or laptop does not have an IEEE 1394
port)

e Install FirePackage (incl. SmartView)

e Start SmartView or other viewer (FireView)

e (Connect camera to PC or laptop and ensure that the camera is powered

® License will automatically be read out from your AVT camera (in case of
problems, contact AVT support)

® (et your first image with SmartView
e Problems? Read Chapter Troubleshooting on page 18.

Installing IEEE 1394 adapter

1. PC: Install the IEEE 1394 adapter according to the instructions you got
from your adapter manufacturer.
Laptop: Insert the IEEE 1394 PC Card into your laptop. Connect external
power supply to the adapter to power the camera or power the camera
via Hirose connector.

Windows 2000/XP(VISTA will detect the hardware automatically and
installs a Windows 1394 driver.

Windows NT4 requires that you install the driver manually via a service
install tool.

Installing FirePackage (incl. SmartView program)

Note Before installing FirePackage, open the following directory:

Read the documents you find in this directory:

@ <CD ROM=>:\products\AVTFirePackage...\

e AVT_FirePackage_x_y_Release_notes.pdf
e AVT_FirePackage_Overview.pdf
e AVT_SmartView_x.y.z_Release_notes.pdf

Note When you install FirePackage the SmartView program will
automatically be installed.

@ Alternatively you can install the Direct FirePackage (then a
special Viewer will be installed: see HTML-Help from this
viewer).

AVT SmartView for FirePackage V2.0.0
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1. Insert the Camera Support CD in the CD ROM drive of your PC or laptop.

An html page will open if the autostart function of your PC or laptop is
enabled.

If the html page does not open, enter the root directory of the CD and
doubleclick index.htm.

2. Scroll down to the software section AVT FirePackage.

3. Click the following links to read the corresponding documents:
- AVT FirePackage Overview
- Release Notes FirePackage
- Release Notes SmartView

4. To start the installation of FirePackage click on AVT FirePackage x.y.zip
A window opens.

Choose Save to Disk and click OK.

In the next window choose a directory and click Save.

Unzip the file.

00 N o U

Doubleclick on setup.exe.

A wizard will guide you through the installation. To go on click Next in
each window.

9. You are asked to choose a directory: Accept the option shown or type
another one. Click Next.

10. Activate all 3 check boxes. Click Next to start installation.
AVT FirePackage is being installed.
The INTEK window appears.

11. Now install the driver for the IEEE 1394 adapter: for each card to be
used with FirePackage, activate the check box.

12. Click Install.

13. Ignore the message box (Microsoft non-certified driver) and continue
the installation.

A wizard will guide you through the installation. To continue click Next
in each window.

A window appears: FirePackage has been successfully installed.
14. Click Close.

Now the FirePackage and the SmartView Program are installed on your PC
or laptop.

AVT SmartView for FirePackage V2.0.0
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Starting SmartView

The SmartView program:
e enables access to all connected IEEE 1394 cameras
e supports almost all smart features of the AVT cameras.

1. Click Start > Programs -> Allied Vision Technologies > FirePackage
- AVT_SmartView

The SmartView window opens.
2. Here you can see all 1394 buses and PCI slots (e.g. 0x040800).

Connecting camera to PC or laptop

Licensing

1. Insert one end of the FireWire cable into your 1394 adapter or 1394 PC
card.

2. Insert the other end of the FireWire cable into your camera.
3. Check that the camera is powered (green LED ON)

You need a license to run the FirePackage. This license is embedded in each
AVT camera. It will be read out with the help of the license file LICENSE.TXT.

Note e LICENSE.TXT and FCTLMAIN.DLL always have to be in
the same directory.

@ e By default the DLLs are used from the Windows
System32 directory.

e If FCTLMAIN.DLL is not in the Windows System32
directory, then FirePackage will look in the directory
where the Viewer (SmartView) is installed.

A typical license file for AVT cameras looks like this:

* FireControl License File
1EEAF9B450220075 Devicecontained Offset=F1000008 (AVT)

After the top line starting with *, each line contains one license. The line
after the top line is exactly as shown above.

The license file will be read from top to bottom until a valid license is found.

AVT SmartView for FirePackage V2.0.0
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Note Newer versions of AVT FirePackage (> 2V6) use additional reg-
istry keys for supplying alternative names and positions for
@ the license file to be stored.
For further information on licensing read the following:

<install dir>\Allied Vision Technologies\FirePackage\Doc\
Licensing.pdf

or ask your local dealer.

AVT SmartView for FirePackage V2.0.0
_________________________________________________________________________________________________________________________________|
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First steps with SmartView

1. After connecting the camera with your PC or laptop, start SmartView
program. In the SmartView entry window you see all FireWire adapters
or cards installed in your PC.

2. In the SmartView entry window open all trees by clicking on the [+]
button. Search for your camera and doubleclick on the camera entry.

5 AVT SmartView 1.7 |X|

Camera View Help

B 7

= OHCILynx [0x050200)
g 0. Fil.e F210B [44T)

Ready

Figure 1: SmartView entry window: example of Pike F-210B

3. The SmartView main window opens and usually one first image is shot
automatically.

AVT SmartView for FirePackage V2.0.0
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Menu

Camera

/1

Overview: SmartView entry window

The menus and icons of the SmartView entry window are explained in the fol-
lowing tables:

Icon

Function Description

General settings | Opens the General settings window

(see Table 5: SmartView entry
window: General settings on page 16)

Here you can adjust settings for con-
necting 1394 cards to the 1394 bus,
image type settings and camera view
settings.

Information Shows version and copyright infor-

mation of AVT SmartView for
FirePackage

Submenu

Open/Close view

Table 3: SmartView entry window: toolbar

Shortcut
Ctrl+0, Enter

Description

Opens or closes a viewer window (main window)

Initialize the camera

Initializes the selected camera

Soft reset

Resets the selected camera

Update firmware...

Updates the firmware of the Guppy/Pike camera
via 1394 bus

Read the application note: How to update
Guppy/Pike firmware at AVT website.

For other cameras: Read the chapter Firmware
update of the Technical Manual or contact your
local dealer.

Format 7 mapping...

Only PIKE: Allows mapping of all possible
Format_7 settings to F7M1..F7M7 (see PIKE
Technical Manual, Chapter Binning and sub-
sampling access)

i . Alt+E Opens the General settings window (see Table

3] . . .

E) Settings... 5: SmartView entry window: General settings on
page 16)
Here you can adjust settings for connecting
1394 cards to the 1394 bus, image type settings
and camera view settings.

Exit Alt+X Quits the application

Table 4: SmartView entry window: menus

AVT SmartView for FirePackage V2.0.0
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Submenu Shortcut Description

View Toolbar Shows or hides the toolbar (see Table 3:
SmartView entry window: toolbar on page 15)
Status bar Shows or hides the status bar
Help About AVT SmartView... Shows version and copyright information of AVT

SmartView for FirePackage

Table 4: SmartView entry window: menus

In SmartView entry window click on Camera > Settings.

The General settings window opens.

Section Check box / combo box/ list Description

Enable initial card states |[J Enable initial card states This function is useful, if you have
more than one card installed and sev-
eral cameras.

Activate this check box and disable
cards you don’t use and set your
working card to False, so that con-
nected cameras are shown automati-
cally.

Card ID list Lists all 1394 cards (connected to
your PC/Laptop) with their ID num-
ber.

To disable a card, set the Disabled
parameter to True.

To open the bus when SmartView is
started, set the AutoOpen parameter
to True. All connected 1394 cameras
of this card will be searched and
opened automatically.

Table 5: SmartView entry window: General settings

AVT SmartView for FirePackage V2.0.0
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Section

Check box / combo box/ list

/1

Description

Camera

1 Automatically open camera views
on startup

Activate this check box to view all
connected cameras automatically,
when corresponding card is opened.

[0 Selected cameras only

Activate this check box to show only
selected cameras from the list, when
SmartView is started.

The list shows all cameras, that have
been connected to your PC/laptop
and have been opened with Smart-
View.

Select one or more cameras by click-
ing on the camera name.

Image file type

| Default type used by
‘Save’ & 'Save as’

Choose your standard image file type
for the Save and Save as operation.

The following types are available:

bmp, jpg, gif, tif, png

L1 Override extension entered by
the user

If you activate this check box, all
settings made within the Save and
Save as command are ignored.

Camera view settings

O Always scale image to view size

Standard setting for each window.

Activating this check box will scale
the camera image to the SmartView
viewer window size. Otherwise the
camera image size is not scaled to
the viewer window size.

O Resize camera view on resolution
changes

Standard setting for each window.

Activate this check box to adapt the
viewer window to each resolution
change of the image size (fixed
modes) or the AOI size (Format 7 set-
tings).

Table 5: SmartView entry window: General settings

AVT SmartView for FirePackage V2.0.0
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Troubleshooting

If the image is completely black, completely white or the image quality is
poor, then try the following steps:

e If not done yet, remove the lens cap.

e If the image is black, open the aperture. If the image is white, close the
aperture.

e If the image quality is poor, try changing the focus.

If you still don't get any image at all, then try the following steps:
e Check the FireWire plug of your camera and PC/laptop.
e (Check the LEDs on the back of the camera.

AVT SmartView for FirePackage V2.0.0
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/1

Icon bar of SmartView (main window)

The following table shows all functions of SmartView (main window) avail-
able via the icon bar.

Icon Function Description
=) Save Saves the image(s) to the file you
have previously set with Save as...
command.
Edit Settings Opens a settings window

Here you can adjust the settings for
the standard registers, e.g. exposure
time or gain (IIDC specification) and
the settings for advanced AVT fea-
tures.

The following tabs are available:

e Format

o C(Ctrl1

o (trl2

e (trl 3 (only for certain color
cameras)

* Trig/I0

e LUT/Shdg.

e Adv1

e Adv2

e Adv 3 (not all cameras)

e (MOS (only for cameras with
CMOS sensor)

Some settings can only be changed

when the camera is in idle mode.

Table 6: Functions of SmartView available via icon bar

AVT SmartView for FirePackage V2.0.0
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Icon

)

Function

Direct register
access

/1

Description

Opens a window (Direct Access dialog
box)

For an example see Figure 3: Smart-
View: example of DirectAccess dialog
(Marlin F-080C-30fps) on page 22.

Enables you to access all features by
their address and to change the reg-
ister of the AVT camera directly.

All settings can be changed while the
camera is running, although some
features will only take effect after
you stop and restart the camera.

Start iso

Acquires images continuously

Multi-shot

Acquires multi images as set in the
Edit Settings - TriggerI/0 tab >
Multishot counter combo box

One-shot

Acquires only one image

Stop

Stops acquiring images (free-run or
multi-shot)

Record

Records images to individual file
names you have set under File >
Recording options...

Display image
coordinates

Displays the image coordinates in a
yellow bubble box on top of mouse
cursor

X

Display image
coordinates and
image values

Displays the image coordinates and
the image values (intensity) in a yel-
low bubble box on top of mouse cur-
sor

(276/115)
159186 114

X

L3

color image b/w image

Table 6: Functions of SmartView available via icon bar

AVT SmartView for FirePackage V2.0.0
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Icon Function Description
Display format Displays the format options in the
- options in status |status bar.
bar Example: 2080x1540x8 (RAWS)
& Increase zoom Increases the image zoom factor
factor
a Decrease zoom Decreases the image zoom factor
factor
1g Quick read set- | Reads settings from file to which you
tings from file have written your settings.
Quick write set- | Writes settings to the file you have
i tings to file choosen.
? About Shows version number, copyright
information and link to Allied Vision
Technologies:
http://www.alliedvisiontec.com/

Table 6: Functions of SmartView available via icon bar

Pike F210E - A¥YT [C 0, N 0] - A¥T Smart¥iew 1.7.0

Format |t 1 | Crl 2 || Trigr1o | LUT/Shdg. | adv 1 | adv 2 | adv 3
Fixed & wariable modes. ..
Formak Colar 150 speed
0430 | (LRt --imwalid -- | |5100
S00xa00 Monole 5200
1024x768 Monolz2 2400
1280x960
F7 mode 0
F7 mode 1 )
F7 mode 2 High SMR mode
F7 mode 3 150 channel off =
F7 mode 4
F7 mode 5 futa Chn,  Frame buffers
F7 mode & [£%3 0 w | |16 &
Format? setkings... (max, 1920 x 132)
Left (£ 2 pe) wWidth (£ 4 pec) Top (£ 2 pe) Height (£ 2 px)
1920 = 132 =
Packet size Auka size Maz Frame rate
96,97 fps
ourtawatie 9] (%] [M1] []

Figure 2: SmartView: example of Edit Settings dialog (PIKE F-210B)

AVT SmartView for FirePackage V2.0.0
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Marlin FOBOC-30fps (CO, ND} - Direct ac...[¥]

Register: | 150 ENABLE v|
Address: |F|:|F|:u:|514 v| [ Read |
Data: | 00000000 | [ write |
#| rw Address Value

2 rd FOFOOG14 00000000

1 wr  FOFOFO4C 00000000

i | 11T ]l|

Figure 3: SmartView: example of DirectAccess dialog (Marlin F-080C-30fps)

AVT SmartView for FirePackage V2.0.0
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Menu structure of SmartView (main window)

Menu

File

Submenu Description

& Save Ctrl+S |Saves the image(s) to the file you have previously
set with Save as... command.

Save as... F12 |Click here to save an image to hard disk or network

drive. Choose file format (BMP, JPEG, GIF, TIFF, PNG)
and directory. After that you can save an image to
this file by clicking on Save.

Recording options...

Click here to configure the recording options. After
that your are able to save images in streaming for-
mat, that means one file with a successive number-
ing per image.

See Chapter Streaming images: recording options on
page 57.

Use deep images Ctrl+Shift+P

Allows to use images with more than 8 bit (depend-
ing on camera model).

See Chapter Using deep images (only MONO16 mode
or RAW16 color mode) on page 58.

Exit

Alt+X

Click here to exit main window of SmartView.

Table 7: Functions of SmartView available via menu

AVT SmartView for FirePackage V2.0.0
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Menu
Camera

/1

Submenu Description

B Free-run Alt+R | Acquire continuous images.

B, Multi-shot Alt+M |Acquire n images.

Bl One-shot Alt+G | Acquire one image.

W Stop Esc |Stop the free-run or multi-shot modus.

& Record Ctrl+R |Record individual images according to the settings
you have made in File - Recording options...
gge Chapter Saving and streaming images on page

Settings > Settings dialog Alt+E Opens the Settings dialog.

® For short overview see Chapter Edit settings
window (for specialists) on page 28.

e For deep description on complex, difficult to
understand settings see Chapter Operating AVT
cameras with SmartView on page 50.

Settings > &4 Quick Read settings
Ctrl+Shift+R

Reads settings from file to which you have written
your settings.

Settings > #§ Quick Write settings
Ctrl+Shift+W

Writes settings to the file you have choosen.

Settings - Select Settings file...

Choose a file where your settings will be stored.

Settings = Read Settings from external file...

Choose an external file from which the stored set-
tings will be read.

Settings > Write Settings to external file...

Choose an external file to which your settings will
be stored.

Settings 2> Search for camera by GUID

Searches by camera ID; Default: activated

LMl Direct access dialog Alt+D

Opens a window (Direct Access dialog box)

Enables you to access all features by their address
and to change the register of the AVT camera
directly.

All settings can be changed while the camera is run-
ning, although some features will only take effect
after you stop and restart the camera.

Options = | [Automatically load settings
on camera open

Activate check box to load settings automatically
when the camera is opened.

Options 2> | [Automatically save settings
on camera close

Activate check box to save settings automatically
when camera is closed.

Options = | [Start Free-Run automatically
on camera open

Activate check box to start free-run automatically
when the camera is opened.

Options > Start One-Shot on camera
open

Activate check box to start one-shot when the cam-
era is opened.

Options = | [Set shutter, gain and white
balance automatically

Activate check box to set shutter, gain and white
balance automatically.

Options = | |Start with display maximized
on camera open

Activate check box to start with the SmartView dis-
play maximized when the camera is opened.

Table 7: Functions of SmartView available via menu

AVT SmartView for FirePackage V2.0.0
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Menu
View

Submenu

Toolbar

/1

Description
Activate check box to display the toolbar.

Status bar

Activate check box to display the status bar.

Set display size to »

Current AOI Alt+9
Current image size Alt+8
Ratio-corrected image size Ctrl+Shift+A
160x120 Alt+1
320x240 Alt+2
640x480 Alt+3
800x600 Alt+4
1024x768 Alt+5
1280x960 Alt+6
1600x1200 Alt+7
User size... Alt+0

The listed formats set the display size of the window
and are independent from camera types. If the dis-
play of your monitor is smaller than the chosen dis-
play size, then the display format is resized
automatically to fit to your monitor.

Additional information »

The following information is available:

Coordinates

Coordinates/Pixel values

Image info Ctrl+Shift+I
Histogram Ctrl+Shift+H

Secure Image Stamp Info (only Marlin, Pike)

Disable display of image

Activate check box to disable the display of an
image.

&, Zoom in Alt+"+" | Click here for zooming in an image.
E Zoom out Alt+"-" | Click here for zooming out an image.
Set zoom=1 Alt+Ctrl+"-" | Click here for setting zoom to 1.

Set maximum zoom  Alt+Ctrl+"+"

Click here for setting maximum zoom.

Resize view on format change

Standard setting for each window.

Activate this check box to adapt the viewer window
to each resolution change of the image size (fixed
modes) or the AOI size (Format 7 settings).

Always scale image to window
Alt+S

Standard setting for each window.

Activating this check box will scale the camera
image to the SmartView viewer window size. Other-
wise the camera image size is not scaled to the
viewer window size.

Reset position of settings dialog

Click here for to reset the position of the settings
dialog. Use this if you cannot see the settings win-
dows after starting SmartView.

AVT SmartView for FirePackage V2.0.0
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Menu
Extras

Submenu

Set async speed

/1

Description

The following values are available: S100, S200,
S400, S800 (only 1394b cameras).

Use manual settings if you want to limit async. com-
munication with camera to lower speed. Helpful in
the case of longer cables (e.g. 20 m at S200) or
needed for communication over up to 100 m using
network cable at S100.

AUTO (activate check box for auto-detection
of max. async speed)

Allow async block transfer

Disabling async. block transfer may be helpful for
the communication with third party cameras.

Drop faulty frames

Activate check box for dropping defective frames. A
frame is called defective, if during transmission of
the frame an error occurred.

Auto-flush logging file

Activate check box for logging messages immedi-
ately into logging file. If check box not activated,
messages will only be logged when buffer full. For
more information see Chapter Using logging func-
tionality of SmartView (*.cmd file) on page 81.

Default: not activated

Adjust channels... Alt+Ctrl+A

Only Pike cameras: see PIKE Technical Manual,
Chapter: Channel balance

View Secure Image Stamp info...

Only Marlin, Pike cameras: see Chapter Secure image
signature (SIS) (MARLIN, PIKE) on page 108

Sequence dialog...

Only Pike cameras: see Chapter Sequence mode
(PIKE) on page 105

Table 7: Functions of SmartView available via menu

AVT SmartView for FirePackage V2.0.0
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Menu Submenu

Help ® About AVT SmartView...

Shows version number, copyright information and
link to Allied Vision Technologies:

http://www.alliedvisiontec.com/

/1

Description

Tooltip help for settings

Activate Tooltip help for settings to get help when
moving mouse cursor over window elements (but-
tons, lists, check boxes etc. of main window and
Edit settings window). You will get tooltips in form
of bubble help.

Example:
Marlin F131B - A¥T [Card 0, Node 0] - A¥T Smart¥iew 1.
Farmak | Ckrl * . =g, [ ady 1 Adw 2 | O
) The available/selected

Fixed &4 fived resolutions and
Format | format 7 modes for this  prate  ISO speed
a40x430 camera fps
B00xA0 fps

1024765

'?.SFEs

F7 mode 0

Table 7: Functions of SmartView available via menu

AVT SmartView for FirePackage V2.0.0
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Edit settings window (for specialists)

Where to find

SmartView (main window): Edit settings

Overview: Edit settings window

Note Display of tabs depends on camera types.
If a camera does not have tab-specific features implemented,
@ the corresponding tab will not be displayed.

Depending on camera type the following tabs may be displayed:
¢ Format tab

e (Ctrl1tab

e Ctrl 2 tab

e (Ctrl 3 tab
(only PIKE/DOLPHIN color cameras and GUPPY interlaced color cameras)

e Trig/I0 tab

e LUT/Shdg. tab

e Adv1tab

e Adv 2tab

e Adv3tab

e (CMOS tab (only CMOS cameras)

AVT SmartView for FirePackage V2.0.0
28



AVT SmartView for FirePackage

Section

/1

Format tab descriptions

Check box/combo box/list/slider

Description

Fixed & variable
modes...

[to be continued on
next page]

Format

Lists the fixed resolutions and Format_7
modes of the camera model.

Depending on the camera model the fol-
lowing formats may be available:

® Fixed formats
- 320x240
- 640x480
- 800x600
- 1024x768
e Format_7 modes
- F7 mode 0
- F7 mode 1

Color

Lists the available color modes of the
selected fixed format / Format_7 mode.
Depending on the camera model and the
selected resolution / F7 mode the follow-
ing color modes may be available:
Mono8, YUV411, YUV422, RGBS, RAWS,
RAW16, RAW12...

Framerate

Lists available frame rates in fixed
modes.
List is invalid for Format_7 modes.

IS0 speed

Lists available ISO speeds.

1394a: S100, S200, S400

1394b: additional S800

The camera will use this speed for the
video data transmission, async. communi-
cation may use another speed. See Sub-
menue Set async speed on page 26.

Debayering

See Chapter Debayering algorithms on
page 50.

High SNR mode

Choose number of images for High SNR
mode. This is an image averaging func-
tion.

See PIKE Technical Manual, Chapter High
SNR mode (High Signal Noise Ratio)

Table 8: SmartView Edit settings: Format tab

AVT SmartView for FirePackage V2.0.0
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Section

/1

Check box/combo box/list/slider Description

Fixed & variable
modes...

[continued]

ISO channel

W

Set no. of ISO channels. (This is a 4-bit
address to identify the source of a video
data stream). Normally set to Auto Chn.
Otherwise all cameras connected to one
bus must have a different ISO channel.

Frame buffers

e
w

By default SmartView reserves 16 frame
buffers per camera in main memory.
You can change that to a max. limit,
which is dependant on your system and
0S. After changing, SmartView displays
how many buffers it currently uses (e.g.
2/786) so as not having to drop any
frames coming from the camera.

The minimum of 3 ensures that normally
no image from camera is to be discarded
because of no available memory.

Format7 settings...
(max. abcd x efgh)

Left/Width/Top/Height

e
w

These are the AOI settings (only avail-
able in Format_7 modes)

For more information see Chapter Setting
AOI (Format_7 settings) on page 94.
Adjust width and height of camera
image.

For images smaller than maximum image
dimensions: adjust upper left corner via
left and top position of camera image on
image sensor.

Packet size

To change packet size first deactivate
Auto size check box.

O Auto size

e
w

Deactivate check box to adjust packet
size for isochronous packets (via slider
or combo box).

Max frame rate

Shows the maximum theoretical frame
rate. See Chapter Calculating frames per
second on page 97.

Table 8: SmartView Edit settings: Format tab
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Ctrl 1 tab descriptions

If available, you can do the following:

e Switch on/off the feature, by activating/deactivating the On check box.

e Switch on/off auto function, by activating/deactivating the Auto check
box.

e Do one-push action, by clicking button.

e Adjust the feature manually by moving the slider or changing the values
directly (entering numbers or clicking up/down arrows.)

Check box/combo box/list/slider Description

Target grey level This is the auto exposure. Works in conjunction with auto shutter
and auto gain.

J Target grey level corresponds to Auto_exposure register
0xFOF00804 (IIDC).

Increasing the auto exposure value (aka target grey value)
increases the average brightness in the image and vice versa.

Shutter Adjust the electronic shutter manually. The set value is to be
multiplied by the time base, which can be set here: Check box
J Timebase on page 40

Gain Adjust the gain manually. Gain will change on the fly. The pos-
sible range depends on the camera model. The value is to be mul-
J tiplied by a constant factor which is dependant on the camera
model.

A higher gain produces greater image noise. This reduces image
quality. For this reason, try first to increase the brightness, using
the aperture of the camera optics and/or longer shutter settings.

Brightness Adjusting the brightness manually changes the IIDC register
brightness at offset 800h. This effectively changes the offset in
J the image. The range is multiplied by a factor, dependant on the
camera model.

Table 9: SmartView Edit settings: Ctrl 1 tab

AVT SmartView for FirePackage V2.0.0
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Check box/combo box/list/slider Description

Gamma Switch Gamma off/on
J 0 = Gamma off
1 = Gamma on

This is a nonlinear stretching of the darker parts and compression
of the brighter parts in the image to accommodate certain human
and display non-linearities. The actual function used is described
in the camera manual.

When using the LUT feature and the gamma feature pay attention
to the following:

e gamma ON > look-up table is switched ON also

e gamma OFF - look-up table is switched OFF also
look-up table OFF - gamma is switched OFF also

® look-up table ON - gamma is switched OFF

White balance Only color cameras

J Here you can do manual and automatic white balance. White bal-

ance is applied so that non-colored image parts are displayed
non-colored. From the user's point, the white balance settings are
made in register 80Ch of IIDC V1.3 or IIDC V1.31 (depending on
camera model).

The values in the U/B_Value field produce changes from green to
blue; the V/R_Value field from green to red.
Sharpness Only available for DOLPHIN, OSCAR, MARLIN and PIKE
J The color models are equipped with a two-step sharpness control,
applying a discreet horizontal high pass in the green/Y channel.

See OSCAR/MARLIN/PIKE Technical Manual, Chapter Sharp-
ness.

Table 9: SmartView Edit settings: Ctrl 1 tab

Ctrl 2 tab descriptions

If available (hue/saturation), you can do the following:
e Switch on/off the feature, by activating/deactivating the On check box.

e Switch on/off auto function, by activating/deactivating the Auto check
box.

e Do one-push action, by clicking button.

e Adjust the feature manually by moving the slider or changing the values
directly (entering numbers or clicking up/down arrows.)

AVT SmartView for FirePackage V2.0.0
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Check box / combo box/ list / slider Description

]

Hue Adjust Hue manually.
J Hue performs a (slight) global shift of all colors in the image.
Saturation Adjust Saturation manually.

Saturation changes the amount of the coloring from nominal
down to zero or up to 200%.

Auto-function AOI

This is a feature to limit the area in which parameters for the
auto functions (auto gain, auto shutter, auto white balance)
are calculated to a fraction of the image size. Can be used to
exclude e.g. the sky from the gain/shutter regulations or per-
form auto white balance in only a specific subarea of the
image.

Switch on/off auto-function AOI by activating/deactivating
Enable check box. Off uses the whole image size for auto func-
tion parameters.

Enter values: AOI width/height/left (coordinate) and top
(coordinate). Allowed steps are shown in the fields
X-Unit/Y-Unit.

To highlight the AOI in the image, activate Show AOI check-
box.

Auto shutter range

Choose standard (Std.) or extended (Extd.) auto shutter
range.

Change lower and upper limit to restrict the auto shutter to
operate between these limits and not the whole range. Useful
for applications where a too long shutter time would cause e.g.
motion blurring in the image.

Auto gain range

Change lower and upper limit.

Change lower and upper limit to restrict the auto gain to oper-
ate between these limits and not the whole range. Useful for
applications where a too high gain would cause noise in the
image.

Table 10:

SmartView Edit settings: Ctrl 2 tab
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Ctri3 tab descriptions (only color progressive)

Ctrl3 tabs have 2 variants:
e Description for color progressive cameras see below

e Description for color interlaced see Chapter Ctrl3 tab descriptions (only
color interlaced) on page 35

Progressive cameras

Check box / combo box/ list / slider Description

Extra features during debayering These two features (hue/saturation) are only available if cam-
era transmitting RAW image and SmartView doing the debayer-
ing process, using one of the following algorithms:

e 2x2 YUV422

e 2x2 LCAA

o 2x2 LCAA+V

It effectively changes both hue and saturation during debayer-
ing on the PC.

See Chapter Additional adjustment of hue and saturation (only
Marlin/Guppy) on page 52.

Hue Adjust Hue during debayering on the PC manually.
(values in degrees)
,
-20 20
Saturation Adjust Saturation during debayering on the PC manually.
(values in percent)
\
] 200

Table 11: SmartView Edit settings: Ctrl 3 tab (progressive cameras)
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Ctri3 tab descriptions (only color interlaced)

Ctrl3 tabs have 2 variants:

e Description for color progressive cameras see Chapter Ctrl3 tab descrip-
tions (only color progressive) on page 34
e Description for color interlaced see below

Interlaced cameras

Check box / combo box/ list / slider Description

Advanced white balance For the interlaced color GUPPYs (GUPPY F-038/038 NIR/044/
044 NIR) using complementary color filters (Cy, Mg, Gr, Ye)
there is a non-standard (non-IIDC) register for white balance
(0xF10080C4 and 0xF10080C8).

This register is similar to the standard white balance CSR: here
each of the four colors can be controlled independently. See
the four sliders in this table.

@ Note: One-push white balance is not available.

Green/Cyan Adjust advanced white balance manually for
! e Green in Format_7 Mode_1 or

u 512 e Green/Cyan in Format_7 Mode_0
Magenta/Yellow Adjust advanced white balance manually for
) e Magenta in Format_7 Mode_1 or

u 512 e Magenta/Yellow in Format_7 Mode_0
Cyan/Magenta Adjust advanced white balance manually for
! e (Cyanin Format_7 Mode_1 or

o 51z e (Cyan/Magenta in Format_7 Mode_0
Yellow/Green Adjust advanced white balance manually for

L * Yellow in Format_7 Mode_1 or
u 512 * Yellow/Green in Format_7 Mode_0

Table 12: SmartView Edit settings: Ctrl 3 tab (interlaced cameras)
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Trig/10 tab descriptions

Section Check box / combo box/ list / slider Description
Trigger Mode The following trigger modes may be
available (depending on camera
i model):

e Internal (continuous output)
* Edge mode(0)
e Level mode(1)

® Progr. mode(15) aka
Trigger_Mode_15

Beside Internal the other modes
require a signal at the trigger pin of
the I/0 (HIROSE) connector to get an
image.

Polarity Polarity of trigger signal (depending
on camera model and mode)
o3 Edge mode(0) and Progr. mode(15):

* Falling
® Rising
Level mode(1):

® |[ow act.
® High act.

Multishot counter Choose number of images the camera

will take.

Trigger delay O On Delay between trigger signal and
image acquisition

On/off only available, when Edge
mode(0)

Delay time in ps for exposure start
after trigger signal

4

4

s

Integration enable delay [O On Delay between integration (shutter)
and output signal integration enable
(IntEna)

Time in ps for delay of integration
enable event (IntEna)

4

Hs

Table 13: SmartView Edit settings: Trig/IO0 tab

AVT SmartView for FirePackage V2.0.0
36



AVT SmartView for FirePackage

Section

/1

Check box / combo box/ list / slider Description

Input/Output pins

List of all inputs and outputs of a
camera.

The number of inputs and outputs
depend on the camera model.

Mode column

For each pin you can choose one of
the following modes:

Input = (Off/Trigger)

Output =
(Off/Direct/IntegrationEnable/
FrameValid/Busy/FollowInp).

Query the camera manual for details
on the signals.

Invert column

This is the polarity bit. The former
Polarity column for the input/output
pins is now called Invert to clarify
the use of this bit. A polarity of low
in former SmartView versions is now
read as Invert:No, meaning the same.

State column

Lists the status of the input/output
pin (Low or High).

1 Poll the I/0 state continually

Activate check box to update the
state of pins every 200 ms.

Table 13: SmartView Edit settings: Trig/IO0 tab
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Section

/1

LUT/Shdg. tab descriptions

Note ® For a detailed description on LUT see Chapter Working
with LUTs on page 71.

@ ® For a detailed description on shading see Chapter
Working with shading on page 64.

Check box / combo box/ list / slider

Description

Lookup tables

1 LUT operation on

Camera-internal LUT on/off

Choose camera-internal LUT

using LUT # -
Displays the uploaded LUT in an
extra window.
Uploads the selected data into the
-LI load
m = chosen LUT number.
into LUT # = Choose LUT number for data upload.

LUT file []

Only available when choosing data
from the file below

Choose directory and file for upload
process.

Import data from column b

starting at b

Only available when choosing data
from the file below

Choose column where LUT is stored
and choose row number where LUT
starts.

Table 14: SmartView Edit settings: LUT/Shdg. tab
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Section

Check box / combo box/ list / slider

/1

Description

Shading correction

[J Shading correction on

Shading correction on/off

[J Show shading data as image

Select shading image as camera out-
put.

shading data from

Builds camera-internal shading
image. Choose number of images to
be averaged (in order to reduce
noise...) for building the shading
image.

(# Flash [ Save ko Flash ]

Use option Flash to save/load shad-
ing image in user sets (inside cam-
era).

Load From Flash

Loads a shading image stored in user
sets (inside camera).

Clear Flash

Clears shading image stored in user
sets (inside camera).

& File [ Download & save as file ]

Use option File to save/load shading
image to/from an external file.

Upload From File

Uploads an external stored shading
image.

Shading data file

v L

Choose different external files for
uploading/saving. The combo box
lists recently used shading files (for
upload/save operations).

Table 14: SmartView Edit settings: LUT/Shdg. tab
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Section

/1

Adv 1 tab descriptions

Check box / combo box/ list / Description

Extended shutter

slider

Absolute time of exposure in ps.

Settings override the standard shutter set-
tings (and vice versa). Max. settings depend
on camera model.

Std. shutter timebase

Timebase

AVT timebase controls the base factor for
the standard shutter register. Camera needs
to be stopped for changes in this register.

Shutter value (Slider Shutter on page 31) is
multiplied with time base.

Test images

Active image

Choose one of the camera-internal images
as image source. Depending on the camera
model you can choose between different
test images.

See AVT Technical Manuals.

Mirror image

O Horizontal
O Vertical

Depending on the camera model you can
flip the image horizontally/vertically. This
is done in hardware in the camera.

Table 15: SmartView Edit settings: Adv 1 tab

AVT SmartView for FirePackage V2.0.0
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Section Check box / combo box/ list / Description

slider

Deferred transport O Hold images Deferred image transport is available for
PIKE, MARLIN, DOLPHIN, OSCAR cameras.

Activate Hold images to stop image trans-
fer to the viewer (SmartView) and store the
image in FIFO.

[0 Fast capture Activates FastCapture mode of AVT deferred
image transport. The sensor is read out at
its maximum speed. Alternatively the sen-
sor is read out at a speed according to the
transmission settings.

Choose number of images which will be sent

when clicking on [ serdimages |. Set to 0

to send all images in FIFO.

# of images to send -

FIFQ size Displays size of internal image FIFO in terms
of frames.

FIFO used Lists number of images currently held in
FIFO.

Read(s) image(s) from FIFO and send

images over bus to SmartView.

O Lock image capture Prevents AVT SmartView from sending ISO-
enable/one-shot command to the camera
when using the black arrows on bottom of
window.

(> ]w] [m] [£]

With Lock image capture activated the

above buttons prepare SmartView viewer
window without starting the camera (ISO
enable).

IEI IEI With Lock image capture on, clicking on
red arrows (free-run, one-shot) starts cam-
era and images are captured into FIFO.

E Capture images into the FIFO using
free-run mode.

E Capture images into the FIFO using
one-shot mode.

Table 15: SmartView Edit settings: Adv 1 tab

AVT SmartView for FirePackage V2.0.0
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Section

/1

Check box / combo box/ list / Description

slider

Version information

Microcontroller/Order Number/

FPGA/Serial number

Lists the version numbers and IDs of firm-
ware (microcontroller/FPGA), the order
number of the camera and the serial number
of the camera.

Section

Table 15: SmartView Edit settings: Adv 1 tab

Adv 2 tab descriptions

Check box / combo box/ list / Description

slider

Serial port (IIDC-1.31)

Bitrate

Choose bit rate for camera’s RS232 serial
port. It can be used to send and receive
data to and from an external device, con-
nected to the camera.

Char length

Choose character length for serial input/
output:

W N
e 7 bits
e 8 bits
Parity Choose parity for serial input/output
2 ® none
e odd
® even
Stop bits Choose number of stop bits for serial
input/output
W

e 1 stop hit
e 1.5 stop bits
e 2 stop bits

® Serial port off
(3 Transmitter on

{3 Receiver on

Disable serial input/output of camera
Enable only serial sending

Enable only serial receiving

() Both on Enable bidirectional serial input/output
Transmit Enter text to be transmitted to camera.
Receive Any data which is received by the camera

via RS232 will be displayed here until the
buffer is full.

Table 16: SmartView Edit settings: Adv 2 tab

AVT SmartView for FirePackage V2.0.0
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Section Check box / combo box/ list / Description

slider
Image stamp & OO Enable Only MARLIN or PIKE CCD cameras: avail-
counters able with firmware V3.03 or newer

See MARLIN or PIKE Technical Manual,
Chapter Secure image signature (SIS)

Activate check box for writing time stamp
(a very precise clock), frame counter and
trigger counter data directly into image
(PIKE: also additional SIS data). After acti-
vating check box these data are stamped at
a selectable row position left in the image.

Choose where these data are put into the
image:

Row

4

Row 0: top of image
Row 1,2,...: rows below top of image
Row -1: bottom of image

Row -2,-3,...: rows above bottom of image

Click to display SIS information (secure

image signature)

Only PIKE: Enter a user value which will be

User value ) .

written into the camera.
Frame Counter Resst| | Frame counter and trigger counter can also
Trigger Counter roei] | De read out asynchronously from registers

(i.e. not out of image).

Displ . . . .
'SPy Activate Display check box for displaying

frame/trigger counter numbers.

Frame counter field displays number of
images taken since clicking on [Reset].

Trigger counter field displays number of
external trigger events since clicking on

fese.

Table 16: SmartView Edit settings: Adv 2 tab
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Section

Check box / combo box/ list /
slider

/1

Description

Color

O Color correction

Depending on camera model:

Activate check box for using built-in color
correction matrix. For certain camera mod-
els the matrix coefficients can be modified

using Adv3 tab.
a 3 x 3 matrix in the RGB color

domain!

Note: It is not an intuitive proce-
dure to change the coefficients of

O Local color anti-aliasing

Only Dolphin F-145C: Activate check box
for less horizontal color fringe.

Camera reset

[SDFtreset] [Inkmhze]

Soft reset: camera feature

Click for rebooting the internal

logic in the camera (FPGA) and forcing the
1394 bus to reset.

Click for setting FPGA back to

default values. No reset of the 1394 bus.

User sets (Memory
channels)

See Technical Manuals, Chapter User
profiles. Used to store/recall custom set-
tings in/from camera.

Saves current settings in chosen user set
Save

[ save ] 1.3).

Loads settings from chosen user set (1..3)
ll!ﬁﬁﬂlll
- without rebooting camera.

Starts the chosen user set (1..3) on next
lﬁﬂﬂﬁﬁlﬂﬂiﬂﬂﬂl
_ camera start automatically.
Set No. = Choose desired user set number for save/

load/set as default action.

User Set No. 0 = factory setting (can not be
changed)

User Set No. 1..3 = save/load/set as default
actions possible

Table 16: SmartView Edit settings: Adv 2 tab

AVT SmartView for FirePackage V2.0.0
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Adv 3 tab descriptions

Section Check box / combo box/ list / Description
slider
Color correction Correction matrix Only cameras with color correction and cor-
Colar cotrection rection matrix feature implemented
Correction matrix
1025 = o s 1000 | €€ PIK'E Technical Manual, Chapter Color
correction
-229 1371 -142 sum is 1000 . . .
To change matrix elements first activate
el A 1354 |sumi= 1000 | color correction check box on Adv 2 tab.
Example shows Pike F-210C Change value in each of the nine fields of

correction matrix manually. Enter values
between -1000 and +2000.

1000 means a factor of 1.0

The row sum is displayed: Pay attention to
the following:

e The sums of all rows should be equal
to each other. If not, you get tinted
images.

e In order for white balance to work
properly ensure that the row sum
equals 1000.

e Each row should sum up to 1000. If
not, images are less or more colorful.

Table 17: SmartView Edit settings: Adv 3 tab

AVT SmartView for FirePackage V2.0.0
45



AVT SmartView for FirePackage / / /

CMOS tab descriptions
(only Guppy F-036 and Marlin F-131)

Note To use this feature number of knee points must be greater 0.
Section Check box / combo box/ list /  Description
slider
High dynamic range | (only Guppy F-036) For Guppy F-036 see GUPPY Technical
mode O HDR mode on Manual, Chapter HDR (high dynamic
(only Guppy F-036) Voltage #1 range) (GUPPY F-036 only)
To use this feature first change number of
= knee points to value greater 0.
Voltage #2 Then activate HDR mode on check box.
_ Guppy F-036: In Knee points choose 1 or
* 2 and enter Voltage value in Voltage #1
Knee points — (and Voltage #2).

Table 18: SmartView Edit settings: CMOS tab

AVT SmartView for FirePackage V2.0.0
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Section Check box / combo box/ list / Description
slider
High dynamic range | (only Marlin F-131) For Marlin F-131 see MARLIN Technical Man-
mode ¢ " ual, Chapter High dynamic range mode
nee points = _
(only Marlin F-131) P (MARLIN F-131B/C only)

To use this feature first change number of
knee points to value greater 0.

Choose number of knee points: 1, 2 or 3.

HDR mode on Then activate HDR mode on check box.

Marlin F-131: Choose Easy mode or Expert
mode by clicking on the radio button.

Display graph For a graphical on-the-fly representation of
the HDR mode activate Display graph check
box.

Marlin F131B {CO0, NO) - HDR Graph
253Grey level 2.3 [7.3dB]
221 O

149 O<g——___Example of
3 knee points

Light intensity

@) Easy mode In Easy mode put slider in the desired posi-
tion (the knee point values will be set auto-
matically). An Easy mode value for the
dynamic gain increase in dB will be shown
(7.4 dB in our example).

Example:
0.0d6 52.0dB

7.4dE
I

Control your setting in the graph.

& Expert mode In Expert mode enter values for Add.time
#1 (#2, #3) manually.

Example:
Shutter time  Add. time #1  Add. time #2 Add. time #3  Total Time
21705 10542 5| |e@9s % | &S % | | 40000

Shutter time and Total time are displayed.

Control your settings in the graph.

Table 18: SmartView Edit settings: CMOS tab

AVT SmartView for FirePackage V2.0.0
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Section Check box / combo box/ list / Description

slider
DSNU/Blemish pixel | (only Marlin F-131B) See MARLIN Technical Manual,
correction O DSNU correction on Chapter DSNU & blemish correction
(only Marlin F-131B) (MARLIN F-131B only)

DSNU = Dark signal non-uniformity

Close the lens or the aperture so that no
light hits the sensor for DSNU and blemish
correction procedures.

Activate check box to use DSNU.

O Blemish correction on Activate check box to use blemish correc-
tion. This will identify and compensate for
defective pixels by using intact neighbors.

[0 Show correction data image |Activate check box for displaying correction
data as image.

Correction data using Builds DSNU/blemish pixel correction image
from the number of images you have chosen

o3 (possible numbers are 1, 2, 4, 8, 16).

[ P rE——— ] ;z;\;esé;c?ae Sctc())rrr(‘;a;]:‘1e:1on data into the correc-

[Load data from flash] Lpads the factory settings into the correc-
tion data storage.

[Delste correction data] Empties the correction data storage.

Table 18: SmartView Edit settings: CMOS tab
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Direct register access window

Note The height of this window can be adjusted, but not the width

(although double arrows are shown).

Definition Direct access window is a tool to write data into registers directly and read
out data from registers directly (in hex code).

Check box / combo box / list Description

Register Lists all accessible registers by
the clear names.

W

Address The address of the chosen regis-
ter is displayed immediately.

Alternatively you can enter an
address in hex code manually.

Data Lists the data that is read from or
written to the chosen register.

Read Reads data from chosen register.
Write Writes data in chosen register.

List # column Counts the number of read/write
actions.

rw column Displays type of action:
rd=read

wr=write

Address column Displays the address of read/
write action in hex code.

Value column Displays the value of read/write
action in hex code.

Table 19: Smart View Direct access window: descriptions
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Vision Technologies

Operating AVT cameras with SmartView

In this chapter you will find descriptions how to operate AVT cameras with
the SmartView software. The most important camera functions are explained
and you learn how to use these functions effectively with SmartView.

Debayering algorithms

Conditions

® Only PC debayering (via SmartView)
e Only color cameras

e Works only in RAW8/RAW12/RAW16/Mono8 mode (depending on spe-
cific camera type); in RAW12/RAW16 mode only 2x2 algorithm available

Where to find
SmartView: [g&'| Edit settings > Format tab

Marlin F201C - A¥YT [C 0, N O] - A¥T Smart¥iew 1.7.0

Fixed & wariable modes. ..

Formak Colar 150 speed Debayering

S20x240 Y411 - irrvalid - | | 5100 Py

640450 Y422 S200

S00xa00

1024x768 2 2

1260960 3§3 mano

1600:x1200

ZE=l Debayering: D e

E; mggz é Choose type 150 channel Wz Loassy
[tk mhA s

Figure 4: Debayering: Example of choosing type (Marlin F-201C)
Only Marlin/Guppy (progressive): additional adjustment of hue and satu-
ration possible (using methods YUV422/LCAA/LCAA+V):
SmartView: [g&'| Edit settings > Ctrl3 tab (color progressive)

Guppy FO46C - A¥T [C 0, N 0] - A¥T Smart¥iew 1.7.0 [
Hue/Saturation: Format | el 1 [ ctrl2 | C3 Trigi1o| LUTYShdg, | Adv 1 | Adv 2|

Adjust

Extra Features during debayvering

Hue

Saturation

Figure 5: Hue and saturation: Example of additional adjustment (Guppy F-046C)

AVT SmartView for FirePackage V2.0.0
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Description

The following Debayering algorithms are available (depending on specific
camera type):

Debayering  Choose type Description Advantages (+) and
algorithm disadvantages (-)
none none No Debayering
2x2 2x2 Debayering is done on a 2x2 pixel |+ fastest (lowest CPU con-
basis sumption) algorithm
- color fringe
2x2 mono Showing only mono image (lumi- + no color fringe (b/w image)
nance Y only) of 2 x 2 Debayering - no color information
3x3 3x3 Debayering is done on a 3x3 pixel |+ less color fringe
basis - less resolution
- more CPU consumption
2x2 2x2 YUV422 |Same algorithm as in AVT Marlin or |+ faster algorithm compared to
Dolphin cameras (produces the same | LCAA an LCAA+V
color output as Marlin or Dolphinin | _ more horizontal color fringe
YUV422 mode). than LCAA
Color low-pass filtering with two hor-
izontally neighboring pixels
2x2 LCAA LCAA = local color anti-aliasing + less horizontal color fringe
Color low-pass filtering with four - vertical color fringe
horizontally neighboring pixels
2x2 LCAA+V | LCAA+V = local color anti-aliasing + less horizontal and less ver-
including vertical color smoothing tical color fringe
Color low-pass filtering with a win- |- slowest algorithm (highest
dow of four horizontal and two verti-| CPU consumption)
cal pixels

Table 20: Description of Debayering algorithms

AVT SmartView for FirePackage V2.0.0
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The following Bayer patterns are available (depending on specific camera

type):

Bayer pattern Description

auto. pattern Default

RGGB Use one of these patterns, if e.g. older SmartView

GRGB versions use the wrong Bayer pattern.

CBRC The first two letters are of 1st row of sensor, the
R last two letters are of 2nd row of sensor.

BGGR R=red; G=green; B=blue

Table 21: Description of Bayer patterns

Additional adjustment of hue and saturation (only Marlin/

Guppy)
® The following three types (YUV422, LCAA, LCAA+V) convert the trans-
ported RAWS8 image to the YUV space.

® Here the (different) low-pass filtering of the color information (U and V
values) is done to reduce color fringe at edges.

® Hue and saturation require intensive computations in YUV. If hue is 0
(no hue rotation) and saturation 100 (=100%) a more efficient back
transformation is done.

e After that conversion to BGR space (Windows RGB) is done.

Advanced white balance (only Guppy color
interlaced)

Conditions

e Only Guppy color interlaced cameras
e Only Format_7 Mode_0 and Mode_1

AVT SmartView for FirePackage V2.0.0
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Where to find

Only Guppy (interlaced): adjustment of advanced white balance possible:
SmartView: Main window: g Edit settings - Ctrl3 tab

Guppy FO3BC - AYT [C D, N 0] - A¥T Smart¥iew 1.7.0

Advanced white balance

Advanced white balance:
Adjust

Green, Magenta,
Cyan, Yellow

GreenfiCyan

Magenta/ellow
=

Cyan/Magenta
R

‘ellow/Green

Figure 6: Advanced white balance: Example of adjustment G, Mg, Cy, Ye (Guppy F-038C)

Description

Guppy interlaced cameras use color sensors with complementary color filters
(Green, Magenta, Cyan and Yellow). This sensor type is not covered by IIDC
specification.

White balance requires a set of advanced registers to allow adjustments. In
addition, there are two different Format_7 modes available:

® Mode_0 which effectively bins two rows and

e Mode_1 which is a frame integration mode

Thus Mode_0 and Mode_1 perform differently from the point of white balanc-
ing.

Format_7 Mode_O0 In Format_7 Mode_0 (field integration, two lines are binned during sensor
readout) advanced white balance is adjustable for each of the individual
(binned-) pairs:
e Green/Cyan
* Magenta/Yellow

Cyan/Magenta

Yellow/Green

Format_7 Mode_1 In Format_7 Mode_1 (frame integration, two lines are binned in the soft-
ware) advanced white balance is adjustable for each of the individual com-
plementary colors:

®* (reen

® Magenta
e (yan

e Yellow

AVT SmartView for FirePackage V2.0.0
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Operating AVT cameras with SmartView

There is no one-push function. Set the camera to auto to perform continu-
ously white balance or switch auto off after the correct white balance is
achieved.

AVT SmartView for FirePackage V2.0.0
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Saving and streaming images

Conditions

e Hard disk or network drive with enough space

® Recording: Make one or more images. Then the recording options are
available.

e Use deep images: only available with camera models having MONO16
(monochrome models) or RAW16 (color models)

Where to find

SmartView: Main window: File > [ Save

SmartView: Main window: File - Save as...
SmartView: Main window: File & Recording options
SmartView: Main window: File > Use deep images

FIE Camera Wiew Extras  Help

W Save Chrl+3
Sawve as... F1z
Recording options. ..

IUse deep images  Chrl+Shift+P

Exik Ak

Figure 7: Where to find: Saving and streaming images

Description

Saving images to hard disk or network drive

To save a single image to hard disk or network drive, use the File > Save
as... command, choose directory and file name on your hard disk or network
drive and choose the file format. The following file formats are available:

o BMP (*.BMP, *.DIB, *.RLE)

e JPEG (*.JPG, *.JPEG, *.JPE, *.JFIF)
o GIF (*.GIF)

o TIFF (*.TIF, *.TIFF)

o PNG (*.PNG)

AVT SmartView for FirePackage V2.0.0
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File format Compressed/lossless  Description

BMP Uncompressed, lossless |Best file format for all your applica-
tions. All image processing tools can
open BMP files.

JPEG Compressed, lossy JPEG is a lossy format and file size is
much smaller than bmp. Be aware
that you may loose details in the
image.

GIF Uncompressed, lossless |Use GIF only if it is acceptable to
store image only with 256 colors.

TIFF Uncompressed, lossless |Tagged image file format, used in the
printing industry. Use TIFF only if
required; e.g. your image processing
tool works only with TIFF format.

PNG Compressed, lossless PNG has compression and works loss-
less.

Table 22: Description of file formats

When the file exists, you can choose File = [gJ Save or just click on the &
button to overwrite the file.

AVT SmartView for FirePackage V2.0.0
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Streaming images: recording options

Note Precondition: First make one or more images, otherwise the
Recording options menu is not available.

@ Streaming is not meant in the sense of a video file. You will
have to use third party software to do offline conversion from

the streamed images to a video file.

Alternatively Streampix software from www.norpix.com can
be recommended for directly recording to a video file.

To continuously save images to hard disk or network drive in a streaming for-
mat, use the File > Recording options and configure your recording in the
Recording options window (seeTable 23: Recording options window:
Descriptions on page 58).

Recording options

File name options
Current File name
| | [ Select. .. ]
Mumber of digits
Processing options
Record every . Frame
( Ok, | [ Cancel ]

Figure 8: Recording options window

Note Be aware that it is not guaranteed that each and every image
from the camera is finally recorded to disk. SmartView is not
@ optimized for unlimited recording.
You may improve the performance by setting the Frame buff-

ers in Format tab of SmartView (see Frame buffers on page
30) to the maximum your system (and main memory) allows.
Usually this amount of images can be recorded without loss
of frames.

AVT SmartView for FirePackage V2.0.0
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Section

Check box / combo box/ list / slider Description

File name options

Current file name After choosing number of digits click
, choose directory, enter
file name, file format and click on
Save.

First choose number of digits for file
name of all images in streaming for-
mat.

Default: 5

Example:
recording_test00000.bmp
recording_test00001.bmp

e

Number of digits |3 5

recording_test99999.bmp

Processing options

Choose if you want to record:
® every frame (1)

® every second (2)

every third (3)

Record every | % 1| . frame

every nth (n)

Definition

Table 23: Recording options window: Descriptions

To start recording click on | #

Using deep images (only MONO16 mode or RAW16 color
mode)

Deep images means: more than 8 bits. Images with a bit depth greater than
8 are always transported in 16 bit, due to the definition of the standard. Only
certain Pike models are able to transport images in a AVT specific Packed 12-
Bit Mode. Depending on the camera the significant bits will be between 8
and 16 bits. The bit depth is MSB aligned, that means a 10-bit image in the
16-bit format appears to have the same brightness as a 12-bit image, but the
12-bit image contains 2 more LSBs important for the finer grey level details
in an image.

AVT SmartView for FirePackage V2.0.0
58




Operating AVT cameras with SmartView / / /

Availability depending on camera model:

Camera model Deep images available?  Advantages (+) and

disadvantages (-)
Dolphin b/w Yes Deep images have the following advantages (+)
Oscar Yes and disadvantages (-)
Marlin b/w Yes + 1images with enhanced dynamic
Pike b/w and color Yes - Windows operating system is unable to dis-
Guppy No play more than 8 bit. For display in

SmartView the images are reduced to the
upper 8 bit. Other image processing tools
must be able to handle images with more
than 8 bit.

Table 24: Which cameras can use deep images?

For cameras with available deep images (MONO16 or RAW16) click on
File > Use deep images to use images with more than 8 bits.

Activating/deactivating deep images is stored automatically when closing
the window.
Enhancements during deep-image support are:

e Extended histogram: activating/deactivating deep images changes dis-
play of histogram instantaneously

® Tooltip pixel values are adjusted.

e Saving 16-bit images is possible: with Save as... command the ending
*.raw is set automatically (although you can choose bmp, jpeg, gif, tiff,
png only in the dialog) to the file name.

e Recording with 16-bit images is also possible.

Note Saving images in deep image format, the file format is RAW,
which means without header or trailer, as coming from the

@ camera.
The higher byte comes first (the so called big endian format)
and the assembled pixel value is MSB-aligned. That means:
Unused lower bits are zero.

Example: a sequence of two 16-bit pixel ,7F FO FE 50” of a
12-bit image refers to ,,07FF OFE5" (equals ,,2047 4069 in
decimal) values of the ADC.

Caution Working with deep images, more processor power is needed:

/ The viewer may be slower leading to dropped frames.

AVT SmartView for FirePackage V2.0.0
59



Operating AVT cameras with SmartView / / /

Loading and saving camera settings as XML
files

Conditions

® To save and load camera settings to and from an XML (eXtensible
Markup Language) configuration file, the MSXML parser must be
installed on your system.

e Msxml3ger.msi: Installation file for the MSXML parser, version 3 service
pack 4, German. For information or other languages see
http://www.microsoft.com/downloads

® For quick read/write settings you first must create/save an xml file as
standard xml file (Select Settings file... see below)

Where to find

File M= Yiew  Extras  Help

& | » Freerun alk+R e B S 98T R

B, Mulki-shat Alb+r
M Cne-shok alk+13

Settings Settings dialog. . Alk+E

] Direct access dislog...  Al+D

Eﬁ Quick Read Settings  Chrl+3hifk+R,

Opkions
ﬁ Quick \Write Setkings  Chrl+Shift -+

Select Settings file. ..

Read Settings from external file. ..

Wyrite Settings to external File. ..

Search For camera by GUID
Figure 9: Where to find: Loading and saving camera settings as XML files

Camera > Settings - Read settings from external file...
Camera > Settings > Write settings to external file...
Camera > Settings > Select Settings file...

Camera > Settings > 4 Quick Read Settings

Camera > Settings > #§ Quick Write Settings

AVT SmartView for FirePackage V2.0.0
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Description

Most of the configurations of cameras and features in SmartView can be
saved on your computer in an XML file. Save your most used configurations
in different XML files. This gives you the advantage to choose quickly
between different settings.

For very quick loading/saving of one special setting you can use the Select
Settings file... command and then the

® Quick Read Settings &4 button or
® Quick Write Settings #£§ button

As an alternative save your camera settings as user settings in the camera.

AVT SmartView for FirePackage V2.0.0
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Working with the histogram function

Conditions
e Minimum size of histogram window is 256x128.
e Using deep images, histogram will show values up to 16 bit.

Where to find

View > Additional information > Histogram
(or use short key: Ctrl+Shift+H)

File  Camera Extras Help

= 7 Taokar
. Skatus bar

Set display size to

Additional infarmation 3 @4 Coordinates
Disable display of image Zoordinates/Pixel values
iz Image info__ Chrl-Shift+T

) Zoom in Al -
PR Histogram  Crl+Shift+H
'El Zoorn ouk Ale4+"-"
Set zoom=1 Al Cerl4--"
St maimunn 2oom Ale+Cerl4+" 4"

Resize view on format change

Always scale image bo window — AlE+3

Reset position of setkings dialog

Figure 10: Where to find: Histogram

Description

A histogram shows the brightness distribution of an image (e.g. in an 8-bit

image there will be 256 levels of brightness ranging from 0...255 with 0 as

darkest and 255 as brightest value). The sum under the curve is equal to the

total amount of pixels. Use the histogram for analyzing and optimizing

brightness distributions.

e Monochrome cameras show one red curve in the histogram

® Color cameras show three curves (red, green, blue) in the histogram

e Interlaced cameras show four curves (red, green, blue, yellow) in RAW
mode and three curves with debayering (red, green, blue)

AVT SmartView for FirePackage V2.0.0
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Marlin F201C {C0,M0) - Histogram

o<

number of pixefs
at most freque
value

x-position of Max.

middle of x-axis

Figure 11: Example of histogram (Marlin F-201C)

Histogram element Description

X axis Available values:

8-bit image: 0...255

12-bit image: 0...4095 (Oscar)

14-bit image: 0...16383 (e.g. PIKE Mono16)

16-bit image: 0...65535 (e.g. Oscar with 16 images or PIKE with 4
images; both in HSNR mode)

y axis Number of pixels with value at x axis

Max: Number of pixels at most frequent value (the corresponding x value
is marked with an additional vertical black line: x-position of Max.)

127 (8-bit) Middle of x-axis

255 (8-bit) Maximum x value

Table 25: Description of histogram

AVT SmartView for FirePackage V2.0.0
63



Operating AVT cameras with SmartView / / /

Using histogram
The following 3 examples illustrate how to use the histogram function:

1. Experiment how the histogram changes on opening/closing aperture:
- Open aperture: curve(s) move to right side
- Closing aperture: curve(s) move to left side

2. Manual white balance (e.g. single-color/monochrome surface):
Consider green curve as reference

Adjust UB slider of white balance so that blue curve overlaps green
curve

Adjust VR slider of white balance so that red curve overlaps green
curve

Manual white balance done

3. To get a feeling for contrast of image:
- If an image has little contrast, histogram will show Gaussian like
curve(s) very likely.
- If an image has very high contrast, histogram will show much more
irregular curve(s).

Working with shading

Definition

Shading correction is also known as flat-field correction. It is effectively a
multiplicative correction of each pixel. The cameras perform this task in
hardware, thus not consuming any CPU power or delaying the image. In order
to generate the correction factors per pixel, only an offline task in the cam-
era does all the job.

Upon generation of the shading image in the camera, it can be uploaded to
the host computer for non-volatile storage purposes.

With the Pike, you are now able to store your generated shading data in flash
memory inside the camera, allowing you to calibrate your imaging setup once
under controlled conditions and then just load the stored shading data with
one command after camera startup without having to transfer data from the
PC to the camera.

For this, you are now able to switch the external source/destination from
“file” (like it was possible before) to “flash”, allowing you to store to flash,
load from flash and to clear the flash instead of downloading and saving
shading data to a file or uploading from a file.

Additional information

For additional information on the shading correction feature read the fol-
lowing chapters:

e DOLPHIN Technical Manual, Chapter Shading correction
e (0OSCAR Technical Manual, Chapter Shading correction

AVT SmartView for FirePackage V2.0.0
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e MARLIN Technical Manual, Chapter Shading correction
¢ PIKE Technical Manual, Chapter Shading correction

Conditions

® Dolphin cameras (only Dolphin F-145B and Dolphin F-201B)
e (scar cameras

e Marlin cameras

e Pike cameras

® (Guppy cameras have no shading correction)

Where to find
SmartView: |g&| Edit settings > LUT/Shdg. tab

Pike FZ10C - A¥T [C 0, N 0] - AYT SmartView 1.7.0
Format |t 1 bl 2 | Cerl 3 | Trigito| LUTIShda. |ady 1 | adv 2 | adv 3|

Lookup tables

|:| LUT operation on wsing LUT # Display LUT
Uplaad |a kable For inversion w | imbo LUT #

Conﬁgure LT File |LLIT_Osu:ar_Cu:untrast.u:sv |
shading correction

Irnport data From calurnm | Cal & starting at | Row 2
ﬁhading correckion
Shading correction on Show shading data as image
shading data from | 256 imagelsy
) Flash
[ Download & save as File ] [ Upload From File ] Clear Flash
(%) File
Chading data file |D:'|,F‘ru:ugramme'l,.ﬁ.llied Yision Technologies\FirePackar |E])

[#] Don't aute hide IEI EI IEI IEI

Figure 12: Shading correction: Example (PIKE F-210C)

Description

Usage Shading correction is used to compensate for non-homogeneities caused by
lighting or optical characteristics within specified ranges.

To correct a frame, a multiplier from 1...2 is calculated for each pixel in
1/256 steps: this allows for shading to be compensated by up to 50%.

AVT SmartView for FirePackage V2.0.0
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Besides generating shading data off-line and downloading it to the camera,
the camera allows correction data to be generated automatically in the cam-
era itself.

Note For conditions and special features depending on the camera
family/model see the Technical Manuals listed in Chapter

@ Additional information on page 64.

There are two storing possibilities:
e After generating the shading image in the camera, it can be uploaded to
the host computer for nonvolatile storage purposes.

® The shading image can be stored in the camera itself. (Pike only)
The following pictures describe the process of automatic generation of cor-

rection data (PIKE F-032C). Surface plots and histograms were created using
the ImageJ program.

255.01

surface plot
—

5500 poeet®
histogram

I ]
0 256

Count: 307200  Min: 79
Mean: 135.337 Max. 19
StdDev. 30.497 Mode: 88 (4200)

Figure 13: Shading correction: Source image with non-uniform illumination

AVT SmartView for FirePackage V2.0.0
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On the left you see the source image with non-uniform illumination.

The surface plot on the right clearly shows a gradient of the brightness
(0: brightest = 255: darkest pixels).

The histogram shows a wide band of gray values.

By defocusing the lens, high-frequency image data is removed from the
source image, therefore its not included in the shading image.

How to prepare for shading image

Shading correction compensates for non-homogeneities by giving all pixels
the same gray value as the brightest pixel. This means that only the back-
ground must be visible and the brightest pixel has a gray value of less than
255 when automatic generation of shading data is started.

It may be necessary to use a neutral white reference, e.g. a piece of paper,
instead of the real image.

To generate a correction image do the following:

1.
2.

In SmartView main window click Edit settings = LUT/Shdg. tab

In the Shading correction section activate [#] Shading correction on
check box.

Activate [¥] Show shading data as image check box.

Choose the number of images ~ | to use for building the shad-
ing image (shading data). The recommended number of images for shad-
ing correction is listed in the table below.

Camera type Recommended number of images for shading correction

Dolphin 4, 8,16
Oscar 4,8, 16
Marlin 4,8, 16
Pike 2, 4,8, 16, 32, 64, 128, 256

Table 26: Recommended number of images for shading data

Click on .

The automatic generation of shading data is started. The camera pulls in
the number of images which were set in the combo box. An arithmetic
mean value is calculated from them (to reduce noise).

After this, a search is made for the brightest pixel in the mean value
frame. The brightest pixel(s) remain unchanged. A factor is then calcu-
lated for each pixel to be multiplied by, giving it the gray value of the
brightest pixel.

All of these multipliers are saved in a shading reference image. The
time required for this process depends on the number of frames to be
calculated and on the resolution of the image.

AVT SmartView for FirePackage V2.0.0
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Note For conditions and special features depending on the camera
family/model see the Technical Manuals listed in Chapter

@ Additional information on page 64.

How to load a shading image out of the camera

Two saving mechanisms are possible:

® Saving shading reference image to flash (currently only Pike family)

® Saving shading reference image to file (all camera models with shading
correction)

e Shading images can also be generated or modified with image process-
ing software. You can use this mechanism to overlay symbols or gener-
ate a cross hair in the image by simply generating a ,synthetic shading
image” with the symbol or the cross hair.

For saving to flash ... For saving to file...
e Choose @ Flash. e (Choose (@ File.
e C(lick [ Save to Flash ] . e Click [Du:uwnlu:uad & save as file ] .
e (lick [E , choose directory and enter file
name.

The shading reference file is saved...

internal into flash memory ‘ in an external file

Table 27: Saving shading reference image to flash or data file

6. Focus the lens again.

The image below will be seen, but now with a considerably more uni-
form gradient.

AVT SmartView for FirePackage V2.0.0
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255.0

surface plot

histogram

0 256

Count: 307200  Min: 139
Mean: 157.039 Max: 162
StdDev: 2.629  Mode: 158 (84449)

Figure 14: Example of shaded image

e 0On the left you see the image after shading correction.

e The surface plot on the right clearly shows nearly no more gradient of
the brightness (0: brightest = 255: darkest pixels). The remaining gra-
dient is related to the fact that the source image is lower than 50% on
the right hand side.

e The histogram shows a peak with very few different gray values.

AVT SmartView for FirePackage V2.0.0
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How to load a shading image into the camera
To load a generated correction image back into the camera do the following:
1. In SmartView main window click Edit settings > LUT/Shdg. tab.

For loading from flash ... (inside camera) For loading from file... (outside camera)

In the Shading correction section choose ...
e Choose (@ Flash. e Choose (& File.

e (lick | LoadfromFlash | . o  (lick | Upload From file | .

* Click [...] , choose directory and enter file
name.

The shading reference file is uploaded...

from flash memory inside camera ‘ from external file outside camera

Table 28: Saving shading reference image to flash or data file

AVT SmartView for FirePackage V2.0.0
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Working with LUTs

Definition Inimage processing, look-up tables are often called LUTs, and they link index
numbers to output values.

Conditions
e All AVT cameras have LUT feature.

Where to find

SmartView: Main window:

£ Edit settings > LUT/Shdg. tab

Pike F210C - A¥YT [C 0, N O] - A¥T Smart¥iew 1.7.0

crrl 2 | el 3 || TrigiIo | LUT/Shdg. |adv 1 || adv 2 | Aady 3

Lookup tables

|:| LUT operation on wsing LUT # Display LUT
Uplaad |a kable For inversion w | imbo LUT #

LUIT File |LLIT_Osu:ar_Cu:untrast.u:sv |

Format || Ckrl 1

\ Irnport data From calurnm | Cal & starting at | Row 2 )
Conﬁgure Shading correction
loo k-up tables Shading correction on Show shading data as image
(Lum)
) Flash
[ Download & save as File ] [ Upload From File ] Clear Flash
(%) File

Shading data file |D:'|,F‘ru:ugramme'l,.ﬁ.llied Yision Technologies|\FirePackar |E]

[#] Don't aute hide IEI EI IEI IEI

Figure 15: Look-up tables (LUT): Example (PIKE F-210C)
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How many?

Usage

Example

Gamma LUT

/1

Description

Depending on the model AVT cameras provide from 1 up to 63 user-defined
look-up tables (LUT).

Camera type ... has how many LUTs? Description

PIKE 16 (# 0-15) The LUT # starts always

GUPPY 1 with 0.

MARLIN 1 Camera types having

0SCAR 1 only one LUT: the LUT #
cannot be changed.

DOLPHIN 64 (# 0-63)

Table 29: Number of LUTs depending on camera type

The use of one LUT allows any function (in the form Output = F(Input)) to be
stored in the camera's RAM and to be applied on the individual pixels of an
image at run-time.

The address lines of the RAM are connected to the incoming digital data,
these in turn point to the values of functions which are calculated offline,
e.g. with a spreadsheet program.

This function needs to be loaded into the camera's RAM before use.

One example of using an LUT is the gamma LUT: see Chapter Using Smart-
View's built-in LUTs on page 74.

The gamma LUT is known as compensation for the nonlinear brightness
response of many displays e.g. CRT monitors. The look-up table converts the
incoming bits from the digitizer to outgoing bits (for values see following
table).

Camera type

incoming ... bits

outgoing ... bits

PIKE 14 up to 14

GUPPY 10 8

MARLIN 10 8

0SCAR 12 8

DOLPHIN 12 8, 10 or 12 (depending
on model, video format
and mode)

Table 30: Gamma LUT: incoming/outgoing bits

AVT SmartView for FirePackage V2.0.0
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Using AVT’s spreadsheet LUTs (camera family dependent)

For each camera family AVT delivers specialized spreadsheets with a variety
of LUTs which you can use immediately.

To use AVT's spreadsheet LUTs do the following:

1.

Choose data from the file below in the combo box after ,

click [E and choose directory and LUT file you like to use. (Example:

LUT_Pike_Gamma_040_150.csv. Description: see table below. Or use

your own *.csv file.).

- All functions in the delivered AVT ...Gamma_040_150.csv file start
in row 2 (first row = header row). The first look-up table with
gamma=0.4 is Col B. The steps between two columns is 0.05. So
gamma=0.9 for example is Col L.

- All functions in the delivered AVT ...Contrast.csv file start in row 2
(first row = header row). The first contrast table with 0.25 is Col B
and the last contrast table with 4 is Col Q.

From the two combo boxes + | choose column (example: Col B)
and row (example: Row 2) for the function to be applied.

Click .

The chosen LUT is uploaded to the camera.

To get a feeling how the LUT looks like click .
A graph of the chosen LUT is displayed.

Note Because AVT camera families have different bit depths there

is a need for different LUT files (see the following table).

@ As examples AVT delivers spreadsheet LUTs for each camera

family:
e (Gamma tables
e (ontrast tables

AVT SmartView for FirePackage V2.0.0
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Camera type

... is delivered with LUT files

/1

Description

PIKE LUT_Pike_Gamma_040_150.csv
LUT_Pike_Contrast.csv

GUPPY LUT_Guppy_Gamma_040_150.csv
LUT_Guppy_Contrast.csv

MARLIN LUT_Marlin_Gamma_040_150.csv
LUT_Marlin_Contrast.csv

0SCAR LUT_Oscar_Gamma_040_150.csv
LUT_Oscar_Contrast.csv

DOLPHIN LUT_Dolphin_Gamma_040_150.csv

LUT_Dolphin_Contrast.csv

...Gamma_40_150.csv

provides gamma tables (gamma functions
with gamma 0.4 up to 1.5, using steps of
0.05)

...Contrast.csv

provides LUTs for increasing or decreasing
the contrast for an image. Each of them has
16 tables with contrast values ranging from
factor 0.25 to factor 4. A factor of 4 means
that the gradient in the middle of the LUT
is steeper by a factor of 4.

Table 31: Description of LUTs depending on camera type

Using SmartView’s built-in LUTs

SmartView has the following LUTs for using without any (external) *.csv files:
See Table 32: Description of LUTs available in SmartView on page 75.

To use them do the following:

1. Choose any of the built-in LUTs (a table for...) in the combo box after
and choose a LUT # where this LUT will be written to.

2. Click .

The chosen LUT is uploaded to the camera.

3. To get a feeling how the LUT looks like click .

A graph of the chosen LUT is displayed. In the following table you find
example graphs (Pike F-210C) for SmartView's built-in LUTs.

AVT SmartView for FirePackage V2.0.0
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Name of LUT (SmartView) Description Display LUT
a table for gamma = 0.7 | Table with the following ...
function: ax:16383

Output=(Input)®’

8191 IB333I
a table for gamma = 0.45 |Table with the following - O
function: ax:16383
Output=(Input)®-4>
8191 IB333I

Table 32: Description of LUTs available in SmartView

AVT SmartView for FirePackage V2.0.0
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Name of LUT (SmartView) Description Display LUT
a table for inversion Table with the following | S emee e ————
function: iax:16383

The identity graph is mir-
rored at the middle axis.

8191 IBBSS'
a table for identity Table with the following | (e =
function: ax:16383
Output=Input
8191 15333l

Table 32: Description of LUTs available in SmartView

AVT SmartView for FirePackage V2.0.0
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Working with trigger

Conditions

® During HDR mode level mode trigger (Trigger_Mode_1) is not possible.

* The multi-shot counter also controls the number of shots in
Trigger_Mode_15.

Where to find
SmartView: Main window: || Edit settings - Trig/I0 tab

Pike FZ10C - A¥T [C 0, N 0] - A¥T Smart¥iew 1.7.0 %]
Format | Ctrl 1 | Ceel 2 | Ceel 3 | THQTO |LUTShdg. |Adv 1 | adv 2 | adv 3
( Trigaer Mulkishiok counter \

Mode |Internal V| Polarity: | nok availabh

Trigger delay Integration enable delay

/ Input/Oukput pins

conﬁgure Fim Mode Irvvert Skate
o Input 1 Trigger Mo Loy
trigger and Input 2 Off N Low
O Cukput 1 IntegrationEnable Mo Lo
IHPUt/OUtPUt Qukput 2 Follow Inp Mo Lo
Oukpuk 3 Busy Mo Loy
Qukput 4 Qff Mo Lo

\D Poll the I/ stabe continually )
[¥] Dor't auto hide IEI EI IEI IEI

Figure 16: Trigger and Input/Output: Example (PIKE F-210C)

AVT SmartView for FirePackage V2.0.0
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Description

ALl AVT cameras support IIDC conforming Trigger_Mode_0 and
Trigger_Mode_1 and special Trigger_Mode_15 (bulk trigger).

Trigger mode ...also known as Description
Internal Continuous mode The camera runs with an internally generated trig-
ger.

The camera sets the shutter time according to the
value set in the shutter (or extended shutter) reg-
ister.

Trigger_Mode_0 Edge mode The camera triggers one image precisely (aka
asynchronously) with a voltage edge received via
trigger pin of the I/0 connector.

The camera sets the shutter time according to the
value set in the shutter (or extended shutter) reg-
ister.

Trigger_Mode_1 Level mode The camera triggers one image precisely (aka
asynchronously) with a voltage edge received via
trigger pin of the I/0 connector.

The camera sets the shutter time according to the
active low time of the pulse applied (or active
high time in the case of an inverting input).

The trigger signal thus serves dual purposes:

® First to set the trigger moment and

e secondly to instruct the camera how long to
shutter (integrate).

Use this mode for overriding the 67 seconds long

time integration limit or if you need to adapt to

brightness changes but without using the shutter

register and software calls.

Trigger_Mode_15 Programmable mode Is a bulk trigger, combining one external trigger
event with continuous or one-shot or multi-shot
internal trigger.

Table 33: Description of trigger modes

Configuring trigger modes
Perform steps To configure the trigger modes do the following:

1. In Trigger section choose your desired mode (Internal, Edge mode(0),
Level mode(1), Progr. mode(15)).

2. For Edge mode(0) or Progr. mode(15) choose the Polarity of the trigger
signal (Falling or Rising). For level mode(1) choose the Polarity of the
trigger signal (Low act. or High act.).

AVT SmartView for FirePackage V2.0.0
78



Operating AVT cameras with SmartView / / /

3. In Multishot counter section set the number of images for the camera to
take in succession.

4. If you choose Edge mode(0): In Trigger delay section you can set a trig-
ger delay (activate On check box) and a delay time in ps for the trigger
signal to become effective.

5. In Integration enable delay section you can switch on/off (On check
box) the delay of the integration enable event. Enter the delay time in
us. Use this e.g. if you fire a flash with IntEna and want to delay when
the flash is fired relative to the trigger.

Scenarios for trigger modes

The following scenarios show some examples when the three trigger modes
are useful.

Trigger mode Additional information

Typical scenario

Moving objects to be triggered |Motion blur (the amount of
precisely at the same position. |movement during the shutter is
open) may also affect the image
quality. Thus a controlled and
bright illumination (or flash
driven by IntEna signal of cam-
era) with a proper and short
shutter time may be required.

Trigger_Mode_0

Trigger_Mode_1 e Moving objects to be trig- | This mode emulates the behavior
gered precisely at the same |of popular analog cameras.
position.

® Brightness changes to be
controlled via the trigger
signal itself.

Trigger_Mode_15 ® Grabbing exactly one image

based on the first external
trigger.

® Filling the camera's internal
image buffer with one exter-
nal trigger without overrid-
ing images. (By setting
Multi_shot counter =
#iframes fitting in internal
memory)

e Grabbing an unlimited
amount of images after one
external trigger
(surveillance)

The Technical Manuals of the
cameras have in depth examples
how to set up these three exam-
ples.

Table 34: Typical scenarios for trigger modes

AVT SmartView for FirePackage V2.0.0
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Perform steps

Configuring input/output pins

Each input pin and each output pin can be configured individually to your
needs for example the above mentioned triggering of the cameras.

To configure the input/output pins do the following:

1.

In Input/Output pins section choose for every input and output pin the
desired mode. To change a mode, click on the mode field. A combo box
opens: click on the desired mode.

For each pin you can choose one of the following modes:
Input = (0ff/Trigger)

Output =
(Off/Direct/IntegrationEnable/FrameValid/Busy/FollowInp)

Choose the Polarity bit in the Invert column. To change an Invert entry,
click on the invert field. A combo box opens: click on No or Yes to
change the Polarity bit.

Note The former Polarity column for the input/output pins is now

called Invert to clarify the use of this bit. A polarity of low

@ in former SmartView versions is now read as Invert:No,

meaning the same.

If you set more than one input for trigger, all inputs are log-
ically ANDed.
The State column lists the status of the input/output pin (Low or
High).

Activate Poll the I/0 state continually to update the state of pins
every 200 ms.

AVT SmartView for FirePackage V2.0.0
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Using logging functionality of SmartView
(*.cmd file)

Conditions

e Appropriate start option must be supplied.
® Log file is created in folder of viewer executable.

Where to find

Has to be done manually. See Description.

Description

SmartView provides a logging facility for errors that might have occurred dur-

ing the operation of the program. This is helpful if you want to debug prob-

lems in cooperation of the software with the cameras and the associated

hardware in question.

e The logging file is created only if an appropriate start option is sup-
plied.

® The log file is created in the same folder as the viewer executable.

There are two options for the log file:

e It is only flushed every 8000 characters or after closing SmartView.

e Tt is auto-flushed when needed.

Setting via Extras > Auto-flush logging file (May slow down system). See
Submenue Auto-flush logging file on page 26.

The following log levels are listed in decreasing severity and include all the
log levels above them:

o "-f"fatal

o ‘"-e":error

e "-w":warning

e "-i":info

AVT SmartView for FirePackage V2.0.0
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There are two ways to use the logging functionality:

First way Place a link to SmartView on the desktop and modify the properties of the
link accordingly.

Eigenschaften von AVT_SmartView_1_7.exe .

Allgemein | Yerknupfung |K|:um|:uatil:|ilitét || Sicherheit|

FR

=
ﬁf’? AT _Smartiew_1_7.exe

Zielhyp: Arwwendung

Zielort; Smartiiew

Ziel: | ckagehSmartfiewhdd' T _Smartfiew 1_7 exe -i|
Auzfubren in; | "D:AProgrammesalied Yizsion TechnologieshFir |

T aztenkombination: | K.eine |

Auzfubren: | Maormales Fenster b |

K.ommentar: |Fu||-featureu:| wigwer application for 84T camer |

[ Ziel suchen... ] [.-'-‘-.nderes S_I,Iml:u:ul...] [ Enweitert. .. ]

[ OF. ] [ Abbrechen ] [Ubernehmen

Figure 17: Properties dialog of SmartView

Second way Alternatively create a *.cmd file with the options
(e.g. SmartView.exe -i) in the SmartView directory.

2 smartview.cmd - Editor |:||E X|

Datei Eearbeiten Format  Ansicht ¢

start AvT_smartview 1_7.exe -1

Figure 18: SmartView.cmd file
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Channel balance (only PIKE)

Conditions

e ALL KODAK PIKE sensors: channel balance
(color cameras: Format_7 mode and RAW mode/no Debayering)
(b/w cameras: Format_7 mode and Mono mode)

Where to find

Channel balance: Extras - Adjust channels

% Pike F210C - AVT [C 0, N 1] - AVT SmartView 1.7.0 AFE channel adjustment (%)

© File  Camera ‘Wiew N3

2 “hannel adjustment
@ | 2 Set async speed J 214 s
Allove async block transfer b
Drop Faulty frames -2045 2047

[ Do one-push adjuskment ]

Adjust channels ... Al+Ctrl+A

Secure Image Stamp info ... ; - " n
Please select an image with an equalized vertical

Sequence dislog ... . : A .
inkensity distribution

Figure 19: Channel balance: Example (Pike F-210C)

Description

PIKE channel balance

Technical
background To achieve more speed, the Kodak sensors of the Pikes are read out horizon-
tally via two separate channels, so two ADCs are involved which may have to
be configured differently. A standard adjustment between the channels is
done at production time, but under certain circumstances, an intensity step
might still be visible from left to right.

Perform steps To be able to make the step disappear, there is an extra dialog available from
the viewer window.

1. Click Extras = Adjust channels or press Alt+Ctrl+A.

For using this dialog, the camera must be in Format_7 and in RAW
(color cameras) or MONO (monochrome cameras) modes. If you are using
RAW modes, make sure not to use the viewer debayering because the
pure sensor data is needed.

2. Using a pattern that has the full range of intensity values along a verti-
cal line in the middle of the image, start image capturing and either
select the channel adjustment value manually (by slider or by value) or
click Do one-push adjustment, possibly multiple times.

AVT SmartView for FirePackage V2.0.0
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The final value will only be active as long as the camera is powered and may
be stored (among others) in user sets. (The original value may always be
retrieved when loading factory set 0).

Note For more information read PIKE Technical Manual, Chapter

Channel balance.

AVT SmartView for FirePackage V2.0.0
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Using HDR mode (CMOS cameras)

Conditions

®  Guppy F-036: HDR mode of Micron MV022 sensor

e Marlin F-131: HDR mode of FillFactory IBIS5B sensor

e For HDR mode: number of knee points must be greater 0.

Where to find

H

DR: || Edit settings = CMOS tab, Section High dynamic range mode

Guppy FO36E - A¥T [C 0, N 0] - A¥T Smart¥iew 1.7.0 [
Formnat | kel 1| Chel 2 | Trig/IC || LUTShdyg. | Adv 1 | Ady 2 | CMOS

High dvnamic range mode
HOR. mode an Yolkage #1 knee points | 1 E
s 3 | |

Figure 20: HDR mode: Example (Guppy F-036B)

Description

Guppy F-036: Micron MV022 HDR mode

Configure
HDR
Technical
background T
a
b

he HDR mode of the Micron MV022 sensor allows for two knee points. They
re controllable in an easy mode, which means that the draining voltage may
e set for both knee points (measured from the minimum voltage) and the

time is assigned automatically by the sensor.
Perform steps On CMOS tab:

1.

Enter voltage levels from 0 to 31.

A value of 0 means 0.5625 Volt (each step meaning an increase of
0.0625 Volt).

If you select two knee points, the second value must be less than or
equal to the first value.

AVT SmartView for FirePackage V2.0.0
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Note For more information read:

e Chapter CMOS tab descriptions on page 46, Section High
@ dynamic range mode (only Guppy F-036)

* GUPPY Technical Manual, Chapter HDR (high dynamic

range) (GUPPY F-036 only) [approx. 5 pages]

Marlin F-131: IBIS5B HDR mode

The HDR mode of the IBIS5B sensor allows for three knee points. This
enables the high dynamic range of the sensor to be compressed into 8 bit,
preserving interesting details of the image. This mode is also known as mul-
tiple slope (dual slope).

Marlin F131B - A¥T [C 0, N 0] - A¥T Smart¥iew 1.7.0 E|
|Format | cerl 1 | ol 2 | Trigi1o | LuTyshdg. | adv 1 [ adv 2 | CMOS | : .
ﬂgh dynamic range mode . Mar 13' bO_toe Grap 2.0x [5:5dB)
HOR mode on Display graph knee points n D'l S p lay 4 L . o
® Eass‘u:'| mode F 520
0.0dE 69,3d6
o  [eas | | | 9raph
() Expert mode _>
Shutter time Tatal Time:
= o .
DSMUElemish pixel correctio 2 kn ee p o1 nts
|:| DSMNU correction on |:| Show correction data image
[ Blemish correction on Correction data using
[ Save data to flash ] [Load data from flash ] [Delete correction data ]
oot ]33] ] ] Lightntensity
.
Configure

HDR

Figure 21: HDR mode of Marlin F-131B (2 knee points + Easy mode + Display graph)

Perform steps On CMOS tab:
1. Change number of knee points to value greater 0 (Example: 2).
2. Activate HDR mode on check box.

3. In Easy mode put slider in the desired position (the knee point values
will be set automatically.
In Expert mode enter values for Add.time #1 (#2, #3) manually.

4. Activate Display graph check box to display the HDR Graph window.

AVT SmartView for FirePackage V2.0.0
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Note For more information read:

e Chapter CMOS tab descriptions on page 46, Section High
@ dynamic range mode (only Marlin F-131)

e MARLIN Technical Manual, Chapter IBIS5A multiple

slope (High Dynamic Range mode).

AVT SmartView for FirePackage V2.0.0
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Error Messages and FirePackage Error Flags

We analyze and discuss the data flow from an AVT camera (e.g Marlin) to the
main memory of a PC under Windows™ using AVT FirePackage assuming a
FireGrab or FireStack based implementation like e.g. SmartView. First we
notice a frame buffer in the camera, which can hold usually more than one
image in the camera. The frame memory is constructed as a FIFO (firstin first
out) memory. Frame buffer(s) in a camera are beneficial for the sensor han-
dling as well as for additional features (such as deferred image transfer). A
frame buffer in the camera is not primarily intended or needed for secure data
flow aspects.

Gain -
> Oftiset Shading LUT
Analog 10 Bi:/ Correction 10 Bit

EEEES“IJHSCI’T‘ HH || Anal
i ~V
i 1[0 10
Camera Control -
z J L J L
3
3

-

IEEE-1394 ——|—Frame- —
1394a Interface 8Bit |\ —Memaory—]

Figure 22: Block diagram Marlin b/w camera

The frame memory is followed by a much smaller FIFO buffer (size of 4 kByte)
in the 1394 interface (link chip) to buffer the data prepared to send of about
one 1394 cycle.

Data then is sent via a DMA mechanism to the corresponding 1394 receive
buffer in the PC, which has also usually the size of 4 kByte.

Speed of the PCI (express) bus is high enough and latency of it is usually very
low so that no overflow or underflow of Receive-FIFO is occurring.

AVT SmartView for FirePackage V2.0.0
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A block diagram of the incoming receive OHCI chip (by TI) interface shows
the details:

Serial
TPC' Internal i ROM L
ar] O ] Registers DHCI PCT Pawer
A Mymi & CLERUN GPIOs
u n | 150 Transmit = s MISC
Al Contexts = e Interface
2 & | Async Transmit = Transmit
i Contexts e FIFO
b
u n | Physical DMA & Link
e & Reaponae = Tiansanit
[y |
> Resp =
T Timeout Receive @ T
- Acknowledge v
1
Host I
Bus Caniral PHY .
Interface Arbiter Rugister Cycle Starl w
&
r Accass Gemrain( & TRE
& Status Cycle Monitor
Im::‘tm Monitor -
o PHY |
_ Link
Reguest Synthesized Interface
Fillers el Fassl
I
s General t Link |
W) Request Receive [ Receive [
g o | Async Response | Receive
ki Receive - FIFO o
+#
e 120 Receive e
o Contexts d

Figure 3-1. TSB12LV26 Block Diagram

Figure 23: Block diagram of incoming receive OHCI chip (by TI)

If an error occurs, the Receive FIFOQ is most probably the critical section.

Other devices of the PC, such as network adapter or USB or peripheral devices
may also occupy the PCI bus so that the performance for the 1394 part can
be negatively influenced or becomes too low.

Debugging this situation requires the temporal deactivation of these periph-
eral devices accompanied by lowering the packet payload of the 1394 device.

With the use of MS low level device driver for 1394 ports, errors in the low
level data flow which are created by the hardware such as Receive-FIFO over-
flows are not reported to the application.

FirePackage on the other hand replaces the MS device driver by a specific
(monolithic) driver for the 1394 device class which fully reports errors to the
application. The following is a list of the various error messages, generated
by the driver and the associated dlls.

AVT SmartView for FirePackage V2.0.0
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Note While it is not the purpose of this document to explain each
and every theoretically possible error, it might be helpful in

the event of debugging to communicate the exact error mes-
sages to the support staff.
Error codes returned by functions

Every function returns a 32-bit error code that contains additional informa-
tion about the error.

The module differs between upper layer error codes (that start with FCE_xxx)
and low level error codes that start with (HALER_xxx).

The following two tables show the coding and describes each error.

HALER xxx codes

Error name Number Error description

HALER_NOERROR 0 No error.

HALER_NOCARD 1 No hardware found.

HALER_NONTDEVICE 2 No logical device could be created for the card (memory
problem).

HALER_NOMEM 3 Not enough memory for this operation.

HALER_MODE 4 Wrong mode for this operation.

HALER_TIMEQUT 5 Time-out occurred.

HALER_ALREADYSTARTED 6 Device was already started and cannot be started twice.

HALER_NOTSTARTED 7 Device was not started.

HALER_BUSY 8 Device is busy at present.

HALER_NORESOURCES 9 Not enough resources (no more interrupts, no threads
etc.).

HALER_NODATA 10 There is no data to acquire.

HALER_NOACK 11 No acknowledge received from the target.

HALER_NOIRQ 12 Expected an interrupt but there was none.

HALER_NOBUSRESET 13 Expected a firewire bus reset but there was none.

HALER_NOLICENSE 14 No license to perform this action.

HALER_RCODEQOTHER 15 Response code of target for actual requested subaction
other then RCODE_COMPLETE (response code is also
returned).

Table 35: HALER_xxx codes

AVT SmartView for FirePackage V2.0.0
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Error name Number Error description

HALER_PENDING 16 Something has been started and is in a pending state.

HALER_INPARMS 17 Error in input parameter (mostly range error).

HALER_CHIPVERSION 18 Wrong chip version for this function.

HALER_HARDWARE 19 Hardware error.

HALER_NOTIMPLEMENTED 20 Function is not implemented.

HALER_CANCELLED 21 A waiting function was cancelled by another user call.

HALER_NOTLOCKED 22 A device is unlocked and needs to be locked for this
action.

HALER_GENERATIONCNT 23 A function for asynchronous communication was called

after a bus reset without having called <FCTLGetBus-
Info> in order to get the new addresses of all existing

nodes.
HALER_NOISOMANAGER 24 Function requires an isochronous resource manager but
there is none.
HALER_NOBUSMANAGER 25 Function requires a bus manager but there is none.
HALER_UNEXPECTED 26 Internal processing error, unexpected value detected.
HALER_REMOVED 27 Target for command was removed.
HALER_NOBUSRESOURCES 28 Either no isochronous channel or isochronous bandwidth
available.
HALER_DMAHALTED 29 An isochronous receive DMA has been halted.

Table 35: HALER_xxx codes

FCE_xxx codes

Error name Number Error description

FCE_NOERROR 0 No error

FCE_ALREADYOPENED 1001 Device is already open and cannot be opened twice.

FCE_NOTOPENED 1002 Device must be opened before.

FCE_NODETAILS 1003 No details for this error

FCE_DRVNOTINSTALLED 1004 Kernel mode driver not installed.

FCE_MISSINGBUFFERS 1005 Not enough buffers for the requested isochronous com-
munication.

FCE_INPARMS 1006 Error in input parameters (mostly range error).

FCE_CREATEDEVICE 1007 Error creating a logical device to connect to the kernel
mode driver.

FCE_WINERROR 1008 Internal windows error.

Table 36: FCE_xxx codes
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Error name Number Error description

FCE_IOCTL 1009 Error while calling kernel mode driver.

FCE_DRVRETURNLENGTH 1010 Data returned from kernel mode driver has wrong length
(version problem).

FCE_INVALIDHANDLE 1011 Handle has invalid value.

FCE_NOTIMPLEMENTED 1012 Function is not implemented.

FCE_DRVRUNNING 1013 Kernel mode driver runs already.

FCE_STARTERROR 1014 Kernel mode driver could not be started.

FCE_INSTALLERROR 1015 Kernel mode driver could not be installed.

FCE_DRVVERSION 1016 Wrong version of kernel mode driver.

FCE_NODEADDRESS 1017 Error in node address specified.

FCE_PARTIAL 1018 User supplied buffer was only filled partially (buffer was
too small).

FCE_NOMEM 1019 Not enough memory for this request.

FCE_NOTAVAILABLE 1020 The requested function is not available.

FCE_NOTCONNECTED 1021 The object is not connected to a real target.

FCE_ADJUSTED 1022 One of the parameters had to be adjusted.

Error name
HALERF_RXHLTISOO

Table 36: FCE_xxx codes

Error flags in global error field

Error codes are returned when a function is called. Error flags are something
different. During processing in the background there is a potential risk that
an error occurs. This error can not be assigned to any function. So these is
handled by the error flags. One or more error flags are set when an error
occurs and are stored within a 32-bit field.

When an application wants to be notified this bit field is posted to the appli-
cation with an WPARAM_ERROR message. In the 32-bit field each bit has a
specific meaning. The following table shows the bit values and explains their
meaning.

HALERF_xxx

Value Error description
0x00000001 |Isochronous RXDMAO had to be stopped.

HALERF_RXHLTISO1

0x00000002 |Isochronous RXDMA1 had to be stopped.

HALERF_RXHLTISO2

0x00000004 | Isochronous RXDMA2 had to be stopped.

HALERF_RXHLTISO3

0x00000008 | Isochronous RXDMA3 had to be stopped.

Table 37: HALERF xxx
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Error name Value Error description

HALERF_RXHLTISO4 0x00000010 |Isochronous RXDMA4 had to be stopped.

HALERF_RXHLTISO5 0x00000020 |Isochronous RXDMA5 had to be stopped.

HALERF_RXHLTISO6 0x00000040 | Isochronous RXDMAG had to be stopped.

HALERF_RXHLTISO7 0x00000080 |Isochronous RXDMA7 had to be stopped.

HALERF_ISORXACK 0x00000100 |Isochronous DMA reported error in packet ACK

HALERF_ISORX 0x00004000 | Unspecified isochronous receive error.

HALERF_TXRESPONSE 0x00008000 | Could not send a response for a request (Read or Write).

HALERF_ASYRX 0x00010000 |Error during asynchronous reception.

HALERF_ASYTX 0x00020000 | Error during asynchronous transmission.

HALERF_PHYTIMEOUT 0x00040000 | The Phy took to long to transfer an information to the
Linklayer chip.

HALERF_HDRERROR 0x00080000 | A packet with an unknown header was received.

HALERF_TCERROR 0x00100000 |Packet with unknown TCode was received.

HALERF_ATSTUCK 0x00200000 | Asynchronous transmit FIFO stucked.

HALERF_GRFOVERFLOW 0x00400000 | General receive FIFO overflowed (access to PCI bus too
slow)

HALERF_ITFUNDERFLOW 0x00800000 |Isochronous transmit FIFO underflow (access from PCI
bus too slow)

HALERF_ATFUNDERFLOW 0x01000000 | Asynchronous transmit FIFO underflow (access from PCI
bus too slow)

HALERF_PCIERROR 0x02000000 | Error while accessing PCI bus.

HALERF_ASYRXRESTART 0x04000000 | Error in asynchronous transmit state machine. Transmis-
sion had to be restarted.

HALERF_NOACCESSINFO 0x08000000 | No access info could be allocated while an external
access occurred.

HALERF_SELFID 0x10000000 | Error while receiving SelfIds.

HALERF_DMPORT 0x20000000 | Error in data mover port (GP-Lynx only)

HALERF_ISOTX 0x40000000 | Error in isochronous transmission.

Table 37: HALERF_xxx
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Setting AOI (Format_7 settings)

Definition

Configure
AOI

AOI = area of interest

Area of interest readout (AOI) refers to a camera function whereby only a
portion of the available pixels are read out from the camera. For example, it
is possible to read out a 640 x 480 pixel area of pixels from a camera that
has a total resolution of 1628 x 1236. The result is a much faster frame rate
and less data to be processed. This is also referred to as partial scan. Various
autofunctions (auto shutter, auto gain, auto white balance) act on the AOL.

Conditions
e (Camera has to be in Format_7 mode

Where to find

SmartView:

| Edit settings > Format tab (Section Format7 settings)

Marlin F201C - AYT [C 0, N 0] - A¥T Smart¥iew 1.7.0
Format |cirl 1 | Crl2 |l 3 | Trig/io | LUT/Shda. | Adv 1 | adv 2 |

Fixed & wariable modes. ..

Formak Color Framerabe 150 speed Debayering
S20x240 i - irrvalid - | | 5100 none v
640450 S200
800600 auko, patkerr
1024x768
1280960 De-Interlace
1600x1200 )
F7 mode 0 High SMR mode
150 chanmel
F7 mode 2

Auto Chn,  Frame buffers

o vt *]

Format? setkings... (max, 1625 x 1236)

Left (£ 2 pe) wWidth (£ 4 pec) Top (£ 2 pe) Height (£ 2 px)

0 ¢ s 3] (o o [s0

e Packet size 1044 Auka size Maz Frame rate
| 1044 || 2n.07fes

[*] Don't auto hide IEI EI IEI IEI

Figure 24: Setting AOI (Format_7 settings): Example Marlin F-201C
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Description

The image sensor on the camera has a defined resolution. This indicates the
maximum number of lines and pixels per line that the recorded image may
have.

However, often only a certain section of the entire image is of interest. The
amount of data to be transferred can be decreased by limiting the image to
a section when reading it out from the camera. At a lower vertical resolution
the sensor can be read out faster and thus the frame rate is increased.

Note The setting of AOIs is supported only in video Format_7.

®

While the size of the image read out for most other video formats and modes
is fixed by the IIDC specification, thereby determining the highest possible
frame rate, in Format_7 mode the user can set the upper left corner and
width and height of the section (AOI=area of interest) he or she is inter-
ested in to determine the size and thus the highest possible frame rate.

SmartView offers a convenient procedure for the selection of an AOI in the
Format tab.

After selecting a Format_7 mode the selection is available. You can choose a
subwindow and its position according to your needs. IIDC specifies for
Format_7 that the transferred packet size has to be adjustable. This is
reflected in the packet size slider which allows to limit the packet size (the
amount of image data, which is transmitted from the camera every 125
microseconds). Lowering this packet size leads to a lower max. frame rate as
displayed in the box.

AVT SmartView for FirePackage V2.0.0
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Height of
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/
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Interest

Figure 25: Area of interest (AOI)

In addition to the area of interest, some other parameters have an effect on
the maximum frame rate:

e Time for reading the image from the sensor and transporting it into the
FRAME_BUFFER

* Time for transferring the image over the FireWire™ bus
e Length of the exposure time

AVT SmartView for FirePackage V2.0.0
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Calculating frames per second

Conditions
® Acquiring images (one-shot, multi-shot, continuous)

Where to find
View = Status bar

The current frame rate is displayed in the status bar.

123 E40c480

Figure 26: Status bar: display of frame rate

Description

AVT implemented a new frame rate calculation. The following chapter
explains the difference between theoretical and displayed frame rate.

New Frame rate calculation

In order to transfer the possible frame rate there is a new way to calculate
the MaxBPP.

The maximum number of packets to be transferred with MaxFPS is deter-
mined. From this MaxBPP is calculated.

It is possible, that one cycle is dropped between two images. Nevertheless
the frame rate formula can be used (Technical Manual, Chapter Frame rates
Format_7). MaxFPS of sensor will be reached.

Example: calculation of frame rate (SmartView vs. Camera)
Calculation of MaxPPF: PPF =1 / (MaxFPS x 125ps) = 38.29

Round off = PPF = 38

Calculation MaxBPP: MaxBPP = 640 x 480 / 38 = 8084.21

This value will be rounded up to N-quadlets: MaxBPP = 8088

AVT SmartView for FirePackage V2.0.0
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Caution SmartView calculates frame rate always according to the for-
mula:

/ frame rate = 1 / ((PPF + 0.5) x 125ps)
Therefore SmartView will show a frame rate of
frame rate = 207.79 fps

whereas the camera reaches a frame rate of approx. ~208.5

Note If you choose other BPP than MaxBPP, then the calculated
frame rate is the same as the former calculating method. So
@ both calculating methods are compatible.
Pike F-032B, 640 x 480, Mono8, MaxFPSccd=208.93

Status bar counters

Usually there is one counter to be seen at the bottom right hand side in the
status bar of the viewing window which counts all frames sent from camera.
Under practical circumstances it can happen that SmartView could not pro-
cess and display all images from the camera or that even the driver could not
reassemble all images from the camera.

Conditions

This usually indicates problems in the hardware or the software such as
® Problems with the cabling (transmission errors)

e Bandwidth over the 1394 bus(es) exceeded

® PCI (Express) bus bandwidth exceeded

e P(I latency problems

® Problems with power consumption reduction options like Intel Speed
Stepping or AMD PowerNow or Cool’'nQuiet, resulting in overflows of
receiving FIFO

e (CPU resources problems

Where to find
View - Status Bar

Description

If there are three numbers displayed, not all frames arriving on the card could
be processed and displayed.

® The first (left) number now shows the number of frames arrived at the
card. (5077 in figure below)

AVT SmartView for FirePackage V2.0.0
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® The second number shows the number of frames lost on driver level
(e.g. due to receive FIFO overflows) (0 in figure below)

¢ The third number shows the number of frames lost due to poor process-
ing capability. (37 in figure below).

The frame rates shown still show the frame rate at the card and, if there is a

second frame rate, the right one shows the processed frame rate.

12.2/12.1 1392x1032

Frames lost due to poor processor capability

Frames lost on driver level

Total transferred frames

Figure 27: SmartView counters

Note The screenshot shows one example which was produced in a
multi-camera environment leaving the Bayer demosaicing
to the PC and forcing it to the most challenging algorithms.
As a consequence SmartView was not able on this PC to keep

up with all the frames from the cameras.
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99



Operating AVT cameras with SmartView

///ALLIED

Vision Technologies

Format_7 mode mapping (only PIKE)

In Pike cameras, you can customize your Format_7 layout with respect to bin-
ning (only b/w) or sub-sampling (b/w and color) via the so-called Format_7

mapping.
Format_7 Mode_0 is factory setting (full resolution) and cannot be changed.

Note For a detailed description of mapping to Format_7 Mode_1 ...
Mode_7 see PIKE Technical Manual, Chapter Binning and

@ sub-sampling access.

Conditions

® Binning: PIKE b/w camera
e Sub-sampling: PIKE b/w or color camera

Where to find

SmartView entry window: Menu Camera - Format 7 mapping...

% AVT SmartView 1.7 X

Wiew  Help

OpenfClose view  Chrl+0, Enker
| Initialize the camera
Soft reset
Llidate firmware. . .
Settings... Alt+E
Exit Alk+

Zonfigure Format 7 For binning/subsampling

Figure 28: Format_7 mode mapping
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Description

To map one or more modes to F7M1 ... F7M7 do the following:

1. In SmartView entry window click on Camera - Format 7 mapping...
The following window opens:

Format 7 Mode Mapping [
Format 7 Mode Configuration: Zonfiguration For Mode: O
0: [Full resolution Decimation Type:
1: &H, &¥ hinning binmi
Z: 2/18H, 2/16Y subsampling inning
3t [default] Horizonkal Decimation:
4 [default] )
5: [default] Full resolution
B [default] Wertical Decimation:
7 [default] )
Full resolution
[ Zamera Mode Info ... ] [ apply ] [ Zancel

Figure 29: Format_7 mode mapping window

2. Choose your mappings and click on Apply.

Note Examples for abbreviations:
H means horizontal; V means vertical

@ 2H binning means 2 x horizontal binning
2/4 H sub-sampling means 2 out of 4 horizontal sub-sam-
pling

F7M1 means Format_7 Mode_ 1

AVT SmartView for FirePackage V2.0.0
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Einning Modes

H  2H

Decimation Type

/1/

Description

Disabled

Chosen mode disappears from the
Format_7 mode list.

Default

Factory settings are used:
Pike cameras:

F7M1:
F7M2:
F7M3:
F7M4:
F7M5: 2/4 V sub-sampling

F7M6: 2/4 H, 2/4 \ sub-sampling

2H binning

2V binning

2H, 2V binning

2/4 H sub-sampling

Binning

Choose binning factors from combo
boxes below.

full resolution

o 2
* 4
e 8

Sub-sampling

Choose sub-sampling factor from
combo boxes below.

full resolution
o 2/4

2/8

2/16

Table 38: Decimation types

For an overview of the available modes, click on Camera mode info.

For PIKE cameras the following window opens:

Format 7 Mode Info (] Format 7 Mode Info (]
Subsampling Modes Einning Modes Subsampling Modes
4H  8H 2i2H | 2/4H | 2Zi8H | 2/16H OH 24 | 4H | &H 2i2H | 2/4H | 2Zi8H | 2/16H
A kS iy w # A # oy - - iy w # A #
A kS 2i4y ¥ # A # 2 2i4y ¥ # A #
A kS 2lav ¥ # A # 4y 2lav ¥ # A #
A kS 2f1ey ¥ # A # av 2f1ey ¥ # A #

il 2l
* "
2 R "
* "
* "

Clase

Clase

Figure 30: Camera mode info window (left: b/w; right: color PIKE cameras)

AVT SmartView for FirePackage V2.0.0
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When saving settings to an XML file, a hash value is calculated and stored for
each Format_7 mode, so that it is not possible to read illegal settings for a
re-mapped mode. This has of course no impact on old settings files. In this
case, illegal settings could be re-read.

AVT SmartView for FirePackage V2.0.0
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Packed 12-Bit Modes (only PIKE)

For PIKE cameras special Packed 12-Bit modes are available.

Conditions

e PIKE b/w camera: MONO12 (color ID 132)
e PIKE color camera: RAW12 (color ID 136)

Where to find

SmartView: g Edit settings > Format tab (b/w: MONO12; color: RAW12)

Pike F210C - A¥T [C O, N 1] - A¥T Smart¥iew 1.7.0

Format |cirl 1 | Ctrl 2 | bl 3 | Trigfto | LUT/Shdag. | adv 1 | adv 2 | Adv 3|

Fixed & variable modes, ..
. Formak Colar Framerabe 150 speed Debayering
Packed 12-Bit| (onci | [monos ~ivald -] (S0 || |ZE2 v
M Ode 640450 Ylv411 S200
\ A00xE00 YI4EE auko, patterr %
N 1024x768 RGES 800
G0 RAMWS De-Interlace
%F? mode 4 @ High SR mode 0 ly 2x2

F7 mode 5 150 channel D bayering
F7 mode &

Auto Chn,  Frame buffers

o vt ?]
Format? setkings,.. (max, 1920 x 10800
Left (+ 2 pex) wWidth (£ 4 pec) Top (£ 2 pe) Height (£ 2 px)
lo 1920 S HE || 1080 3
45 Packet size 4095 Auka size Maz Frame rate

| 4096 | |10.52fps |

[*]Dan't auto hide IEI EI IEI IEI

Figure 31: Format tab: Packed 12-bit Mode (PIKE F-210C: RAW12)

Description

The new Packed 12-Bit Modes are only available in Format_7. At RAW12

color mode there is only 2x2 debayering available. For a detailed description
see PIKE Technical Manual, Chapter Packed 12-bit Mode.

AVT SmartView for FirePackage V2.0.0
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Sequence mode (PIKE)

Definition

Sequence mode is a concept where the camera holds a set of different image
parameters for a sequence of images. The parameter set is stored volatile in
the camera for each image to be recorded. This sequence of parameter sets
is simply called a sequence. The advantage is that the camera can easily syn-
chronize this parameter set with the images so that no uncertainty can occur.

Additional information

For additional information on the sequence mode feature read the following
chapters:

e PIKE Technical Manual, Chapter Sequence mode

Conditions
e PIKE camera

AVT SmartView for FirePackage V2.0.0
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Where to find

Extras - Sequence dialog...

T Pike F210C - AYT [C 0, N 1] - AVT SmartView 1.7.0
Open
Sequence editor

File  Camera Wiew

W ||@ - > Set async speed r
. T Allow async block transfer

Drop Faulty Frames

Auko-Flush logaging File

adjust channels .., Alk+Ckr+A
Secure Image Stamp info ...

Sequence dialog ...

Sequence editor Pike F210C - AYT [C 0, N 1] - A¥T SmartvView 1.7.0
File

Stsp | RepCnt | StepMode | WFormat | WMods | WFps | IsoChn | IsoSpd | Brightness | WhiteBalVR  WhiteBalUB | Shutter | Gain | Sharpness | HighSNR | LUT | Shading | ImgMiror  ImgPosL | ImgPosT | ImgSizeW  ImgSizeH

1 i on i z 75 0 sE00 16 284 284 1000 i i i off  Off Off 0 0 1920 1080

z i on i z 75 0 sE00 16 284 284 00 i i i off  Off Off 0 0 1920 1080

3 i on i z 75 0 sE00 16 284 284 800 i i i off  Off Off 0 0 1920 1080

4 i on i z 75 0 sE00 16 284 284 700 i i i off  Off Off 0 0 1920 1080

s i on i z 75 0 sE00 16 284 284 600 i i i off  Off Off 0 0 1920 1080

[ i on i z 75 0 sE00 16 284 284 500 i i i off  Off Off 0 0 1920 1080

7 i on i z 75 0 sE00 16 284 284 400 i i i off  Off Off 0 0 1920 1080

E o on o 2 75 0 5800 16 284 284 Boo o o o Off  Off Off 0 o 1920 1080

] I | 3

Length: Gt current settings Auto-rewind [] | Disatle Sequence | | Apply Ssquence

Sequence editor Pike F210C - AYT [C 0, N 1] - A¥T SmartView 1.7.0

File
ColorlD | EytePackst  ColCor, | CCCosfFl | CCCosff2 | CCCosf3 CCCoSF | CCCOSFS  CCCosffS | CCCosff7 | CCCosf3  CCCoSFS | OUE..  Oubpuk? | Oubpukd | OO 515 StSlms | SISUssrisl

vazz 409 on 1025 71 S 220 1371 1492 57 T 1354 off off off off off o 0

Wvazz 409 on 1025 71 N 220 1371 142 57 411 1354 off off off off off o 0

Wvazz 409 on 1025 71 N 220 1371 142 57 411 1354 off off off off off o 0

Wvazz 409 on 1025 71 N 220 1371 142 57 411 1354 off off off off off o 0

Wvazz 409 on 1025 71 N 220 1371 142 57 411 1354 off off off off off o 0

Wvazz 409 on 1025 71 N 220 1371 142 57 411 1354 off off off off off o 0

Wvazz 409 on 1025 71 N 220 1371 142 57 411 1354 off off off off off o 0

Wvazz 409 on 1025 71 N 220 1371 142 57 411 1354 off off off off off o 0

< m ®
Length: Gt current settings Auto-rewind [] | Disatle Sequence | | Apply Ssquence

Figure 32: Sequence editor: example for eight different image settings

Description

Perform steps We show you an example how to work with the sequence editor (see screen-
shots above). Our aim is to set up a sequence with eight different image set-
tings (varying shutter from 1000...300 in steps of 100).

1. In SmartView main window click Extras - Sequence dialog...
The sequence editor opens.

AVT SmartView for FirePackage V2.0.0
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2. Click Get current settings.

The currently valid camera settings are gathered and put:
- into the row, in which the mouse cursor is currently positioned or
- after the last row (if no row element is selected)

3. Click 7x Get current settings.

You now have a list of 8 identical rows, named Step 1...8 (first column).
All parameters that are part of sequence steps are listed in the header

row of the table (Step, RepCnt, StepMode, ..., Output4). Scroll to the

right to see all parameters.

4. Go to Shutter column, click the second entry and type 900, click the
third entry and type 800 ... click the 8th entry and type 300.

You have now set up a sequence going from shutter value 1000 ... 300
in steps of 100.

Changing parameters that are part of sequence steps do not change the
settings inside the camera immediately, but in case of clicking Apply
Sequence button.

Note With SmartView do not try out steps altering parameters con-
cerning the transfer via 1394.

@ Use only steps that do not alter the image format or band-
width.

5. Click Apply Sequence to start the sequence.

The whole list of settings is sent to the camera and the sequence mode
is started. sgg | is displayed in the status bar of the viewer window.

6. If you want to disable the current sequence click Disable Sequence. If
you want to enable the sequence again click Apply Sequence.

7. Only PIKE: To determine the behavior of the sequence mode with exter-
nal control additionally to triggering: Go to I/0 tab and change the
Mode of Input 1 or 2 to SeqStep or SeqReset. For more information see
PIKE Technical Manual, Chapter Which new sequence mode features
are available?

AVT SmartView for FirePackage V2.0.0
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Secure image signature (SIS) (MARLIN, PIKE)

Definition Secure image signature (SIS) is the synonym for data, which is inserted
into an image to improve or check image integrity.

Additional information

For additional information on the secure image signature (SIS) feature read
the following chapters:

¢ MARLIN Technical Manual, Chapter Secure image signature (SIS)
* PIKE Technical Manual, Chapter Secure image signature (SIS)

Conditions

e MARLIN camera (cycle time, trigger count, frame count)
e PIKE camera (additional SIS features compared to MARLIN)

AVT SmartView for FirePackage V2.0.0
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Where to find
SmartView: Edit settings > Adv2 tab (Image stamp & counters [¥] Enable)

Pike FZ10C - A¥T [C 0, N 1] - AYT SmartView 1.7.0
Format |t 1 bl 2 | Cerl 3 | Trigito | LUT/Shdg. | adv 1 | Adv 2 |adv 3|

Serial pork (II0C-1,31)

Enable and Bilrate Char length Parity Stap bits
‘9s00bps v | |sbits v| [nore v| [istopbic v

configure SIS

(%) Serial port off {3 Transmitker on () Receiver on () Bath on

Transrik | | Transmik

Receive | | Receive

Image stamp & counkers Colar

Enable  Row: | 0 - | [ show SIS, | Colar carrection
Local color
ser value: | 1] | anti-aliasing
F Count 165 |reset Zamera resek
e Couner | ST —
Trigger Critr. | o |[Reset] [SDFI: reset] [II‘IItIahZE]

Iser sets (Memory channels)

Save [ Load ] [Set as deFauIt] Set Nu:u.
Doortasore 5] o1] [

Figure 33: Format tab: Packed 12-bit Mode (PIKE F-210C: RAW12)

Description

To activate secure image signature (SIS) perform the following steps:
1. In SmartView window click Adv2 tab.
2. InImage stamp & counters section activate [v] Enable check box.

3. Fordisplaying frame/trigger counter numbers activate Display [+] check
box.

For more information see Image stamp & counters on page 43.

AVT SmartView for FirePackage V2.0.0
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Smear reduction (only PIKE)

Definition

Implementation

Reduce
smear

/1

Smear is an undesirable CCD sensor artefact creating a vertical bright line
that extends above and below a bright spot in an image.

Smear reduction is a new feature of PIKE cameras: it is a function imple-
mented in hardware in the camera itself to compensate for smear.

Additional information

For additional information on the smear reduction feature read the follow-

ing chapter:

e PIKE Technical Manual, Chapter Smear reduction

Conditions

e PIKE camera: Use only if smear appears in your images.

Where to find

SmartView: Edit settings > Adv3 tab (Smear reduction Enable)

Pike F210C - AYT [C O, N 1] - A¥T SmartYiew 1.7.0
Formak | Chrl 1 (|Chl 2 | Chel 3 | Trig/1O| LUT{Shdg. | Adv 1 | Ady 2 | Adv 3

Color cotreckion
Carrection matrix

1025 71 -0 sum is 1000
-229 1371 -142 sum is 1000
57 -411 1354 sum is 1000

Smear reduction
Enable

[#] bon't auto hide IEI IEI IE' I:I

Figure 34: Format tab: Packed 12-bit Mode (PIKE F-210C: RAW12)

Description

Use this function only if smear appears in your images. To activate smear

reduction, perform the following steps:

1. In SmartView (Edit settings) window click Adv3 tab.

2. In Smear reduction section activate Enable check box.

AVT SmartView for FirePackage V2.0.0
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